
 

 
 

STN Express®  
Version 8.4 for Windows® 
 
User Guide 
 
 
 
 
 
 
 
 
April 2011 
 
 
 
 
 
 
 
 
 
 
 

 
Copyright © 2011 American Chemical Society 
All rights reserved 

1 



2 



 

Table of Contents 
Welcome to STN Express®, Version 8.4 ....................................................................................... 11 

Logon Setup .................................................................................................................................. 12 

Logon Setup Overview............................................................................................................... 12 

STN® Setup Wizard.................................................................................................................... 12 

Managing Setups ....................................................................................................................... 12 

Creating and Modifying Standard Logon Setups....................................................................... 13 

Secure Session.......................................................................................................................... 14 

Secure and Encrypted Connection to STN via SSL VPN.......................................................... 14 

Logon to CAS RegistrySM BLAST®............................................................................................. 16 

Logon for Academic Accounts ................................................................................................... 16 

Main Menu and Toolbar................................................................................................................. 17 

Main Menu Content.................................................................................................................... 17 

File Menu ................................................................................................................................... 17 

Logon Menu ............................................................................................................................... 17 

Query Menu ............................................................................................................................... 18 

Results Menu ............................................................................................................................. 19 

Setup Menu................................................................................................................................ 19 

Web Menu.................................................................................................................................. 20 

Help Menu.................................................................................................................................. 20 

Main Toolbar .............................................................................................................................. 21 

Online Session............................................................................................................................... 23 

Online Session Overview........................................................................................................... 23 

Connecting to STN..................................................................................................................... 23 

Capturing Transcripts................................................................................................................. 23 

Entering Online Commands....................................................................................................... 24 
 

3 



 

Creating Search Term Command Files ..................................................................................... 25 

Viewing Images Online .............................................................................................................. 26 

Creating Query Summary File ................................................................................................... 27 

STN Online and Results Window Menus and Toolbars ................................................................ 28 

STN Online and Results Window Content................................................................................. 28 

Menus ........................................................................................................................................ 28 

Menu Bar Content...................................................................................................................... 28 

File Menu ................................................................................................................................... 28 

Edit Menu................................................................................................................................... 29 

Online Menu............................................................................................................................... 30 

Query Menu ............................................................................................................................... 31 

Results Menu ............................................................................................................................. 31 

Preferences Menu...................................................................................................................... 31 

Web Menu.................................................................................................................................. 32 

Window Menu ............................................................................................................................ 32 

Help Menu.................................................................................................................................. 32 

STN Online and Results Toolbar ............................................................................................... 33 

Status Bar in STN Online and Results Window......................................................................... 35 

Transcripts ..................................................................................................................................... 36 

Transcripts Overview ................................................................................................................. 36 

Browsing Transcripts ................................................................................................................. 36 

Printing Transcripts .................................................................................................................... 36 

Viewing Images in Transcripts ................................................................................................... 37 

Exporting Transcripts ................................................................................................................. 37 

Modifying Transcripts with Filters............................................................................................... 37 

Customizing Highlighting in Transcripts with Dictionaries ......................................................... 38 

Combining Transcripts ............................................................................................................... 39 

Saving Transcripts ..................................................................................................................... 39 

4 



 

Wizards.......................................................................................................................................... 40 

Using Discover! Wizards............................................................................................................ 40 

Wizards for Hyperlinked Terms.................................................................................................. 43 

Analyze Plus Wizard .................................................................................................................. 44 

Using Analyze Plus .................................................................................................................... 44 

Data Grouping in Analyze Plus .................................................................................................. 45 

Editing Data Groupings of the Analyze Plus Wizard.................................................................. 46 

Creating Charts from Saved Tabulated Data............................................................................. 46 

Charting Terms from the ANALYZE Command......................................................................... 46 

Displaying Records from Analyze Plus Charts .......................................................................... 47 

Analyze Wizard .......................................................................................................................... 47 

Patent Family Manager Wizard.................................................................................................. 47 

Creating a CAS Registry Number and Role Interactive Spreadsheet ....................................... 48 

STN® AnaVistTM Wizards ........................................................................................................... 49 

Save for STN AnaVist ................................................................................................................ 49 

Display from STN AnaVist ......................................................................................................... 50 

Create L# from STN AnaVist for Evaluating with STN Viewer .................................................. 50 

Evaluate with STN® ViewerTM .................................................................................................... 50 

Online Search Aids........................................................................................................................ 51 

Personal Dictionary Search Aid ................................................................................................. 51 

CA Lexicon Search Aid .............................................................................................................. 52 

Structure Searching Overview....................................................................................................... 53 

Structure Searching Steps ......................................................................................................... 53 

Structure Drawing Window ........................................................................................................ 53 

Uploading Structures ................................................................................................................. 53 

Creating Structure Search Queries from Transcript .................................................................. 54 

Using Filters (Screens) to Refine Structure Queries.................................................................. 54 
 

5 



 

Structure Drawing Tools ................................................................................................................ 55 

Vertical Tool Palette................................................................................................................... 55 

Vertical Tool Palette Content ..................................................................................................... 55 

Pencil Tool ................................................................................................................................. 55 

Ring Tool.................................................................................................................................... 56 

Chain Tool.................................................................................................................................. 56 

Eraser Tool................................................................................................................................. 56 

Selection Tool ............................................................................................................................ 57 

Lasso Tool.................................................................................................................................. 57 

Text Tool .................................................................................................................................... 57 

Reaction Arrow........................................................................................................................... 58 

Reaction Role Tool .................................................................................................................... 58 

Reaction Site Tool...................................................................................................................... 58 

Atom Mapping Tool.................................................................................................................... 59 

Functional Group Tool ............................................................................................................... 59 

OR Tool for Functional Groups.................................................................................................. 59 

Horizontal Tool Palette............................................................................................................... 60 

Horizontal Tool Palette Content ................................................................................................. 60 

Current Atom Box ...................................................................................................................... 60 

Common Atoms Palette ............................................................................................................. 60 

Current Bond.............................................................................................................................. 60 

Common Bonds ......................................................................................................................... 61 

Standard Toolbar in Structure Drawing ..................................................................................... 62 

Structure Drawing Menus .............................................................................................................. 64 

Structure Drawing Menu Bar Content........................................................................................ 64 

File Menu for Structure Drawing ................................................................................................ 64 

Edit Menu for Structure Drawing................................................................................................ 65 

Draw Menu................................................................................................................................. 66 

6 



 

Draw Menu for Structure Drawing.............................................................................................. 66 

Variable Points of Attachment in Structure Drawing.................................................................. 66 

Using Repeating Groups............................................................................................................ 67 

Fuse Fragment in Structure Drawing......................................................................................... 67 

Using G-Groups ......................................................................................................................... 68 

Using G-Groups Overview......................................................................................................... 68 

Using G-Groups with Atoms, Shortcuts, or Variables................................................................ 68 

Using G-groups with Structure Fragments ................................................................................ 68 

Template Menu in Structure Drawing ........................................................................................ 69 

QueryDef Menu.......................................................................................................................... 70 

QueryDef (Query Definition) Menu for Structure Drawing ......................................................... 70 

Ring Isolation ............................................................................................................................. 70 

Bond Characteristics.................................................................................................................. 71 

Node Characteristics.................................................................................................................. 71 

Hydrogen Attachments .............................................................................................................. 72 

Non-Hydrogen Attachments....................................................................................................... 72 

Other Attributes.......................................................................................................................... 72 

Generic Definition ...................................................................................................................... 73 

Markush Attributes ..................................................................................................................... 73 

Element Count ........................................................................................................................... 74 

Delocalized Charge.................................................................................................................... 74 

Stereochemistry ......................................................................................................................... 74 

Stereo Display Label.................................................................................................................. 75 

Free Sites................................................................................................................................... 75 

Review Functional Group STN Commands............................................................................... 75 

Structure Query Verification....................................................................................................... 75 

Display Menu in Structure Drawing ........................................................................................... 76 

Window Menu in Structure Drawing .......................................................................................... 77 

7 



 

Reaction Queries........................................................................................................................... 78 

Drawing a Reaction Query......................................................................................................... 78 

Using Functional Groups in a Reaction Query .......................................................................... 78 

WPI Structures............................................................................................................................... 79 

Creating WPI structures............................................................................................................. 79 

Ring Superatoms for WPI Queries ............................................................................................ 79 

Other Superatoms for WPI Queries........................................................................................... 80 

Other Code Concepts for WPI Queries ..................................................................................... 80 

Generating WPI Fragmentation Code Strategy ......................................................................... 81 

Structure Preferences Menu.......................................................................................................... 82 

Structure Preferences Menu Content ........................................................................................ 82 

Structure Preferences: Chemistry.............................................................................................. 82 

Structure Preferences: Layout ................................................................................................... 83 

Structure Preferences: Save Time............................................................................................. 84 

Structure Preferences: Colors/Fonts ......................................................................................... 85 

Structure Preferences: Drawing................................................................................................. 85 

Creating Reports and Tables......................................................................................................... 87 

Reports and Tables Overview.................................................................................................... 87 

Creating Custom Reports and Custom Tables .......................................................................... 87 

Creating Custom Reports .......................................................................................................... 87 

Creating Custom Tables ............................................................................................................ 88 

Selecting Transcripts for Reports or Tables .............................................................................. 89 

Selecting a Template for a Custom Report or Table ................................................................. 89 

Defining the Content of Custom Reports or Tables................................................................... 89 

Creating a Summary Page for a Report .................................................................................... 90 

Selecting Fields for Reports or Tables....................................................................................... 90 

Defining Highlighting in Reports or Tables ................................................................................ 92 

Creating Cover Page for Reports or Tables .............................................................................. 92 

8 



 

Adding Headers and Footers to Reports or Tables ................................................................... 93 

Statistics for Creating Charts for Reports or Tables .................................................................. 93 

Previewing Reports and Tables................................................................................................. 93 

Editing Custom Reports or Tables............................................................................................. 93 

Adding Comments ..................................................................................................................... 94 

Predefined Reports and Tables ................................................................................................. 94 

Creating Predefined Reports and Tables .................................................................................. 94 

Requirements and Output for Predefined Reports and Tables ................................................. 94 

Customizing Content of Predefined Reports and Tables .......................................................... 96 

Selecting or Deleting Answers in Reports ................................................................................. 96 

Saving Reports or Tables .......................................................................................................... 97 

Variable Group Analysis ................................................................................................................ 98 

Overview of Analyzing Variable Groups .................................................................................... 98 

Saving Answers for Variable Group Analysis ............................................................................ 98 

Creating R-Group Analysis Table .............................................................................................. 98 

Structure Tab ............................................................................................................................. 99 

Selecting R-Groups in Structure Tab......................................................................................... 99 

File Tab ...................................................................................................................................... 99 

Fields Tab ................................................................................................................................ 100 

Defining Common Structure for R-Group Analysis .................................................................. 100 

Problems with Defining Common Structure for R-Group Analysis .......................................... 101 

Main Preferences......................................................................................................................... 102 

Preferences Overview.............................................................................................................. 102 

General Preferences................................................................................................................ 102 

STN Online and Results Preferences...................................................................................... 103 

Function Key Preferences........................................................................................................ 103 

Online Preferences .................................................................................................................. 104 

Colors/Fonts/Scaling Preferences ........................................................................................... 105 

9 



 

10 

Links Preferences .................................................................................................................... 106 

Layout Preferences.................................................................................................................. 107 

Discover! Preferences.............................................................................................................. 107 

Account Preferences................................................................................................................ 107 

Postprocessing Preferences .................................................................................................... 108 

Other Preferences.................................................................................................................... 109 

User Data Preferences ............................................................................................................ 110 

BLAST Preferences ................................................................................................................. 110 

CAS Registry BLAST Overview................................................................................................... 111 

Access to the Merged Markush Service from Questel ................................................................ 112 

Using Scripts................................................................................................................................ 113 

What is a Script?...................................................................................................................... 113 

Steps in Defining a Script......................................................................................................... 113 

Script Language Components ................................................................................................. 115 

Operators and Conditions ........................................................................................................ 118 

Script Statements..................................................................................................................... 121 

Script Examples ....................................................................................................................... 139 

Predefined Logon Setup Variables .......................................................................................... 143 

Predefined STN Variables ....................................................................................................... 145 



Welcome to STN Express, Version 8.4 

 

Welcome to STN Express®, Version 8.4 

STN Express, Version 8.4 enhancements are designed to: 

• Increase efficiency of searching and postprocessing 
• Support effective communication of results with others 
• Add power to advanced search capabilities 

New features for tables and reports include: 

• Preview option when creating custom reports and tables  
• Summary option for creating a customized and linked Table of Contents  
• Adding comments to custom reports  
• PDF output for tables, reports, and transcripts 
• Improved usability in table and report creation and output 

Additional features include: 

• Patent Family Manager to make working with patent families easier 
• Query Summary for capturing a definitive record of what was searched 
• Search term command files for script searching in any desired field  

Multiple points of attachment allowed for G-group fragments in structure building 
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Logon Setup 

Logon Setup 

Logon Setup Overview 

For an overview of logon setup, see the following topics: 

• STN® Setup Wizard 
• Creating and Modifying Logon Setups 
• Managing Setups  
• Secure Session 
• Secure and Encrypted Connection 
• Logon for Academic Accounts 
• Logon to CAS Registry BLAST 

For additional information, visit STN Express Technical Support at www.cas.org.  

 
STN® Setup Wizard 

Your online connection and logon information are required each time you connect to STN, CAS 
Registry BLAST, or other online hosts.  This information is stored in a logon setup created by the 
wizard in a file named express.ini located in your My Documents\STN Express 8.4 folder.  The 
STN Express Setup Wizard walks you through the setup process, asking simple questions 
regarding your computer and connection options.   

The wizard automatically starts up if you do not have any setups defined. Press the ’Before I 
Begin’ button for specific details on what you will need to complete the wizard. 

You may also access the wizard from the Setup menu. 

For the latest logon setup information, visit STN Express Technical Support at www.cas.org.   

 
Managing Setups  

Open the STN Setup dialog by selecting Setup and Connections from the Main Menu or by 
clicking the Setup button on the Toolbar.  

Choose from the following options: 

• New - to create a new setup 
• Modify - to modify a setup 
• Duplicate - to copy a setup 
• Delete - to delete a setup 
• Password Options - to password-protect your setups 
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Logon Setup 

Creating and Modifying Standard Logon Setups  

1. Select STN Setup. 
2. Select New to create a new setup.  Choose a Setup Name and click Modify to modify a 

logon setup.  Modify and New use the same dialog.  Click OK.   
3. Click Save and then OK to save and exit.  

Standard Setup dialog options 

Option How to use 
Setup Name Name to identify a specific setup.  The name must be 20 or fewer 

characters and can include any combination of letters, numbers, 
special characters, and spaces. 

Host Name  Select the STN Service Center for your account from the Host Name 
pop-up menu. 

Login ID Entering a login ID is optional.  If you do not enter it here, you will be 
prompted to enter it every time you log on to STN. 

Password Entering a password is optional.  If you do not enter it here, you will 
be prompted to enter it every time you log on to STN. Saved 
passwords are encrypted in the express.ini file.  

Host Settings These are settings specific to STN; many are critically important and 
cannot be changed.   
Select the Command Window box to cause STN Express to open a 
Command Window when you log on to STN.   
The Close Window at logoff box is checked by default; it tells STN 
Express to close the session window after you log off.  Uncheck this 
box if you do not want to close the session window at log off. 

In the Execute at first Host Prompt window, you may enter up to 
five commands.  The first command is sent when the first => prompt 
is received, and the remaining commands are sent, one at a time, 
with each succeeding arrow prompt. By default, a carriage return is 
sent after each line.  Add the keyword NOCR as the last word on the 
last line to indicate that this line is to be displayed in the STN Online 
and Results window, but not sent. This allows you to enter data after 
the defined character string, before it is sent.   

STN Port The STN Port is X by default for commercial accounts.  You may 
change it to the port letter appropriate for your academic account.  

Connect via  Winsock (Internet) option is selected.  The Host Name or IP 
Address, Port, and Echo fields are displayed. Winsock will use the 
Telnet protocol to communicate with the STN servers. 

Standard Logon Use to connect to STN via one of the supported networks.  
Standard Logoff Use to disconnect from STN via one of the supported connections.  
Encryption 
provided by RSA 

Select for secure Telnet session.  

Communication 
Settings 

These settings are for the Winsock (Internet) option selected in 
Connect via.  

For the latest logon setup information, visit STN Express Technical Support at www.cas.org.  
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Secure Session 

To run STN Express using a secure session: 

1. Launch STN Express. 
2. Click the Setup button on the toolbar. 
3. Create a new Setup or modify an existing one. 
4. To set up a secure connection, use the selection triangle in the Connect via: window to 

select SSL-VPN.  

When you are working in a secure session, the lock icon displays at the bottom of the STN 
Express window. 

For the latest logon setup information, visit STN Express Technical Support at www.cas.org.  

Related topic: 

• Secure and Encrypted Connection to STN via SSL VPN 

 
 
Secure and Encrypted Connection to STN via SSL VPN 

SSL VPN connection creates a Virtual Private Network by using the Secure Sockets Layer 
protocol. This provides a secure, encrypted communication connection from your computer to the 
STN servers.  SSL VPN is available for connections only to the STN service centers, not to other 
database suppliers.  

To set up a secure and encrypted connection to STN via SSL VPN:  

A. Configure STN Express   

1. Launch the STN Express main toolbar, but do not log on to STN Express.   
2. Create a new setup by selecting Setup and Connections from the Main Menu of STN 

Express. Alternatively, click on the Setup button on the main STN Express task bar.  
3. Select New in the STN Setup Window.  
4. Enter the following in the Setup Definition dialog box: 

• Setup Name:      SSL-VPN (used in this example)  
• Host Name:        STN-Tokyo or STN-Karlsruhe or STN-Columbus 
• Connect via:       SSL-VPN  
• Logon Method:   Standard (Winsock) (set automatically) 
• Host Name:        localhost  (set automatically) 
• Port:                   55555 (set for STN-Tokyo or STN-Columbus); 6000 (set for  

   STN-Karlsruhe) 

Click OK to exit the setup creation window.  Click Save in the STN Setup window and then  
click OK to exit.  
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Logon Setup 

B.  Establish a secure and encrypted communication with STN 

1. From the STN Express main toolbar, click Web, highlight STN Tokyo or STN-Karlsruhe 
or STN-Columbus, and choose STN [Host Name] Secure Connection.  

2. Confirm all security advices and security certificates. Confirm the web browser’s security 
certificate in order to install and execute the signed JAVA Secure Applet on your PC. 
Confirm the installation and execution of the JAVA Secure Applet.  

3. Wait until the secure connection is established. A separate small status window reports 
the status of connection. A green flashing signal confirms successful connection.  Leave 
the status window open for the duration of your STN Express session.   

4. Launch STN Express.  Click the Logon button from the Main Menu /Toolbar. 
5. Select the SSL-VPN setup in the Select Logon Settings window. Click OK to log on using 

the SSL VPN connection.   

Note: If you have logged on to STN and the session manager window Sent and Received 
packets remain at 0 bytes, you did not log on using the SSL-VPN setup and your session is not 
being encrypted.  Log off from STN and log on again using your SSL-VPN setup. 

Note:  STN Express 8.3 and higher support automated SSL-VPN login.  In those versions, simply 
click on the Logon button and then select the SSS-VPN setup from your list of setups.  

SSL-VPN tips for optimal use 

• While RSA encryption can be used with an SSL-VPN session, it is recommended that 
you choose one or the other as each accomplishes the same thing - a secure and 
encrypted session. Using both together will cause the data being sent back and forth 
from your PC to the STN host to be doubly encrypted and could cause a degradation of 
service. 

• Within your browser, it is recommended that you check "Don't reuse the browser window" 
to keep from accidentally overlaying the session manager window and accidentally 
terminating the connection. 

• The SSL-VPN connection to STN relies for its connection on the secure session manager 
running in the web browser window.  This window is labeled: "DO NOT CLOSE - Secure 
Application Manager". If this is the last active web browser window used and you click on 
a link from another application (including STN), you may get a dialog that asks: "Are you 
sure you want to navigate away from this window?"  If you respond Yes, your SSL-VPN 
connection is disconnected along with your STN session. In your STN window, you will 
see a message: "Connection closed by remote host".  

• If you click "End Session" within the secure application session manager window, this will 
end your SSL-VPN and STN sessions. 

Connectivity Problems 

If you are having problems getting the SSL-VPN session established, here are a few reasons this 
could happen: 

• The HTTPS protocol may be blocked.  Confirm that port 443/TCP is permitted through 
your firewall and/or proxy server.  (To test this, try going to an https website to confirm it 
works, e.g., https://stnweb.cas.org) 
 
 

• You have a pop-up blocker enabled within your browser preventing the session manager 
window from launching.  In order for the SSL-VPN session to connect, you can either turn 
off your pop-up blocker, or add *.cas.org and/or *.fiz-karlsruhe.de as an allowed web site. 
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• Microsoft Internet Explorer:  Choose Tools I Pop-up Blocker I Pop-up Blocker 
Settings and under "Address of web-sites to allow", add *.cas.org and/or fiz-
karlsruhe.de.   

• Firefox:  Choose Tools I Options I Content and click on Exceptions to the right of 
Block pop-up windows and add *.cas.org and/or *.fiz-karlsruhe.de.  

• The web page has been cached and thus instead of running the program that launches 
the secure application manager session, it redirects you to: 

      http://www.cas.org/ONLINE/STN/stnconnect.html or  

      http://www/stn-international.com/sslvpn.html.  

Within a browser window,  

• Choose Tools I Options and in the "Temporary Internet Settings" section, click 
"Delete Files" to clear the cache.  

• In this same section, click the "Settings" button and make sure "Every visit to the 
page" is checked.  

• Finally, close all browser windows and then within STN Express, choose Secure 
session from the appropriate service center within the Web menu and that will 
allow you to establish a new SSL-VPN session.  

 
 
Logon to CAS RegistrySM BLAST® 

To connect to CAS Registry BLAST: 

1. Click Logon from the Main Menu.  Select CAS Registry BLAST.  Alternatively, select 
Blast from the Main Toolbar.  

2. Select the desired setup from the pop-up list and click Yes. Or, click No to enter your 
login ID, password, and STN Service Center manually. 

 
 
Logon for Academic Accounts 

If you have an academic account, you need to change your Account Preferences as follows: 

1. Select Setup from the Main Menu.  Select Preferences and STN Online and Results. 
2. Click the Account tab of Preferences.  

• In the STN Account Type box, select the type of account you have and its features. 
• Under Property Data Databases, select the property databases that the Discover! 

wizards are authorized to access.  
• Under Spectra Databases select the spectra databases that the Discover! wizards are 

authorized to access. 
• Click OK.  



Main Menu and Toolbar 

Main Menu and Toolbar 

Main Menu Content 

The Main Menu contains the following menus: 

• File 
• Logon 
• Query 
• Results 
• Setup 
• Web 
• Help 

 
 
File Menu  

The File Menu on the Main Menu bar contains the following:  

File Menu Item Function 

Edit Text File Edit a text file, such as a script. 

Exit STN Express Close the STN Express application and all associated 
applications. 

 
 
Logon Menu 

Logon on the Main Menu allows you to connect to an online host, e.g., STN, CAS Registry 
BLAST, STN Viewer, and STN AnaVist. 
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Query Menu 

The Query Menu on the Main Menu bar contains the following:  

Query Menu Item  Function 
Prepare Structure Query  Open a new Standard structure drawing window. 
Prepare Command File  Open a file to create a script of commands for your 

online session.   
Check Command File  Check a script for errors. If errors are found, 

STNEdit highlights appropriate script lines and 
displays a message at the bottom of the STNEDIT 
window. To learn the nature of the error, move the 
mouse pointer over the highlighted part of a line. 
Correct the error, save the script, and check the 
script again until no errors are found. 

Edit WPI Strategy  Edit an existing Derwent WPI fragmentation code 
strategy.   

Generate WPI Strategy  Generate a WPI fragmentation code strategy for a 
WPI query structure. 

Print WPI Strategy  Print a WPI fragmentation code search strategy. 
Include WPI Other Code Concepts Select Other Code Concepts to include when 

generating a WPI fragmentation code strategy.  
Create Command File from 
SciFinder Answer Keys 

Create command file from SciFinder answer keys. 

Create Search Term Command File Create a command file from search terms. 
Create Query Summary File  Create a file with a summary of search history. 
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Results Menu 

The Results Menu on the Main Menu bar contains the following:  

Results Menu Item  Function 
Browse Document Open (display) a transcript in Browse mode. 
Print Transcript  Print one or more transcripts. 
Edit Transcript  Edit the text portion of a .trn transcript. 
Export Transcript  Export a transcript to a new RTF file. 
Accounting  Create a cost report for STN online sessions. 
Table Tool  Create a custom table from search results in 

transcripts. 
Report Tool  Create a custom report from search results in 

transcripts. 
BLAST Report with Alignment 
Data 

Create a report that merges BLAST report alignment 
data with fields from an STN transcript. 

Predefined Reports Create a predefined report from search results in 
transcripts. 

R-group Analysis Table Tool  Create a variable group analysis table and identify a 
common substructure for a saved CAS REGISTRYSM 
answer set. 

Create Analyze Plus chart from 
saved data 

Create Analyze Plus chart from saved data 

Edit Personal Dictionary Edit Personal Dictionary 
Edit Data Group File Edit Data Group File in Analyze Plus wizard 
Open  Open the Trnscrpt folder to browse transcripts, 

reports, and tables. 

 
 
Setup Menu 

The Setup Menu on the Main Menu bar contains the following:  

Setup Menu Item Function 
STN Setup Wizard  Create an automated logon setup. 
Connections Create or modify a logon setup configuration for an online 

host. 
Preferences Customize Preferences.   
Save Configuration  Save all logon setups. 
Restore Saved 
Configuration 

Restore all logon setups to the last saved configuration. 
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Web Menu 

The Web Menu on the Main Menu bar contains the following:  

Web Menu Item Function 
STN Columbus Link web browser to STN Columbus services. 
STN Karlsruhe  Link web browser to STN Karlsruhe services. 
STN Tokyo Link web browser to STN Tokyo services. 

 
 
Help Menu 

The Help Menu on the Main Menu bar contains the following:  

Help Menu Item  Function 
Help  Obtain help topics for STN Express. 
View STN Express User Guide Provide access to the STN Express User Guide. 
View Getting Started  Provide access to Getting Started for STN Express. 
Request Help Send an email message requesting help from your STN 

Service Center.  
About STN Express View copyright and version information. 
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Main Toolbar 

Tool Button Name  Function 

 

Create logon setups. 

 

Log on to an online service. 

 

Launch CAS Registry BLAST. 

 

Launch STN Viewer. 

 

Launch STN AnaVist. 

 

Open a Structure Drawing window. 

 

Open transcript or other files for browsing. 

 

Print transcript and other files. 
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Tool Button Name  Function 

                                     

Create custom tables from transcript search 
results. 

 

Create a table from saved R-group analysis data. 

 

Create custom reports from transcripts. 

 

Create a report from transcripts using predefined 
templates. 

 

Open a transcript file for editing. 

 

Set Preferences. 

 

Display a list of help topics. 

 

Quit STN Express. 

This toolbar can be customized by adding a tool button, removing a tool button or gap in the 
same way that the toolbar in the STN Online and Results window may be customized.   

 



Online Session 

Online Session 

Online Session Overview 

The following topics are covered in this section: 

• Connecting to STN 
• Capturing Transcripts 
• Entering Online Commands 
• Creating Search Term Command Files 
• Viewing Images Online 
• Creating Query Summary File 

 
 
Connecting to STN 

1. Click Logon on the STN Express Main Menu or the Toolbar and select STN. 
2. The Select Logon Settings dialog is displayed, if you have more than one setup. If you 

have only one setup, this dialog is not displayed. 
3. Select a setup name and click OK.  If your login ID and password are not included in the 

setup, you will be prompted for them. 

 
 
Capturing Transcripts 

The Capture Session dialog is displayed at login.  

To capture your online session as a transcript, type a name for the session in the File name text 
box and click Open.  The default type format is *.trn.  Select another file type, e.g., RTF (Rich 
Text Format) if you want your transcript captured in Rich Text Format.  

Click Cancel to continue the logon process with no transcript. 

If you choose the name of an existing transcript, a message is displayed asking if you want to 
append or overwrite the existing transcript. You may also cancel session capture. 

Check Show structure queries to include structure queries in your transcript. 

When the connection to STN is completed, the STN arrow prompt (=>) is displayed in the STN 
Online and Results window. 

Refer to Postprocessing Preferences for information on how to change the default file type for 
capturing transcripts or to turn off Capture Session at login. 
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Entering Online Commands  

You may enter STN commands by: 

• Typing them at an arrow prompt (=>) in the text area of the STN Online and Results 
window 

• Using the Command Window 
• Using scripts 

To enter commands in the Command Window: 

1. Select Command Window from the Online menu or click the Command Window tool 
button from the STN Online and Results Toolbar. 

2. Keep the Lock button from the right toolbar of the Command Window in the locked 
position.  In the locked mode, you can type a series of commands and edit them.   

3. To send the commands in the Command Window to STN, use the buttons from the right 
toolbar of the Command Window.  You can send one command line, or multiple 
command lines, at a time. 

To insert a command file into the Command Window:  

1. Click the Open button located on the left toolbar.   
2. Open a command file name in the dialog to insert the contents of the command file into 

the Command Window.  

Click the Save button located on the left toolbar in the Command Window to save the contents of 
the Command Window to a file.   

To clear the contents of the Command Window, click the Clear button located on the left toolbar 
in the Command Window. 

Click the Command Window tool button to disable the Command Window. 

Note:  The Command Window runs a list of STN commands and simple STN Express scripts (i.e., 
those that specify level 1 and level 2 prompts), but it does not understand the full STN Express 
script language described in Using Scripts.  Thus, the Command Window will not run a Command 
File created by the Search Term Command File feature available in Version 8.4.  
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Creating Search Term Command Files 

Search term command files can save you time and effort by automating the process of creating a 
complete search script from a text file of search terms.  This script can then be used as often as 
needed for efficient searching.  

To create a search term command file: 

1. Create a file (e.g., 17pn.tx) with your search terms (e.g., 17 patent numbers) using any 
common text editor program. 

2. Select Create Search Term Command File from the Query menu. This may be done 
offline or during an online session.  

3. In the Create Search Term Command File dialog box, enter or select the following:  

• name of the file containing your search terms ( 17pn.txt) 
• the field code (PN) for the field or fields in which you want your terms to be searched 
• the character(s) you used to separate search terms in your text file (Note: Carriage 

return is always treated as a separator) 
• insert quotation marks around each term that you want to be searched as a bound 

phrase, if desired 
• name for the command file (e.g., 17pnoutput) 

Click OK to save the command file.  A file will be created with the necessary commands 
and field codes appended to the supplied search terms.  

              Click OK in response the message that the command file was created.  

Select Check Command File from the Query menu to check the command output file.  If there 
are no errors in the script file, a message is displayed.   

To run the command file online:  

1. Log on to STN, if you are not online, and enter the STN database(s) where you want to 
run the search.  

2. Select Run Command File from the Query menu and Open the script file (e.g., 
17pnout).  The search is automatically run in the file(s).    
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Viewing Images Online 

Some STN files include technical drawings, chemical structures, trademarks, complete pages of 
publications, and other graphical images.  

 Downloaded images may be in one of these file formats:  

Image Format  File Extension 
TIFF  .tif 
JPEG  .jpg 
GIF  .gif 
Structure Image .gra 

When you display records on STN using display formats that include images, STN Express 
automatically downloads the images to your PC. The files are named according to the name of 
your transcript, a sequential number, and the appropriate extension for the image type. 

For example, if your transcript is named silane.trn, the first TIFF image downloaded is named 
silane001.tif. If the next image is a GIF image, it is named silane002.gif. If you are not capturing a 
transcript, the image files are named IMAGE001.TIF, etc. 

When you browse a transcript offline, you have the option of viewing the downloaded TIFF, 
JPEG, and GIF images in the context of your transcript. Structure images are automatically 
displayed in your transcript. 

JPEG and GIF are common image file formats. Use your own image or graphics software to view 
individual JPEG and GIF images. 

To view a TIFF image while online:  

1. Select View TIFF image from the File menu.   A TIFF File dialog is displayed.   
2. Select a file name and click Open.  The image is displayed in the TIFF File Display 

window. 
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Creating Query Summary File 

You can create a separate file (.pdf or .rtf) summarizing your search history.  This allows you to 
provide a definitive record of what was searched, including relevant structure and sequence 
queries and query attributes.   

To create a query summary file: 

1.   Conduct your searches.   

2.   At the conclusion of the searching you wish to include in the summary, enter one of the 
following commands: 

• SET LHIS ON  
• DISPLAY HISTORY FULL 
• DISPLAY HISTORY NOF 

Alternatively, to ensure that complete history information is always included in your transcripts, 
enter SET LHIS ON PERM.  This command executes a DISPLAY HISTORY NOF each time you 
logoff from STN.  

Note that other types of displays of session history, e.g., D HIS, do not create query summary 
files. 

3.  Select Create Query Summary File from the Query menu.  

4.  Choose the format for the file: .pdf or rtf. 

You can create a Query Summary file while still online or after logoff from the captured .trn or .rtf 
file.  



STN Online and Results Window Menus and Toolbars 

STN Online and Results Window Menus and Toolbars 

STN Online and Results Window Content 

The STN Online and Results window contains the following: 

• Menus 
• Toolbar 
• Text area for entering commands 
• Status Bar  
• Select Discover! Wizard Window that displays Discover! Wizards 

 
Menus 

Menu Bar Content 

The Menu Bar in STN Online and Results Window contains the following menus: 

• File  
• Edit 
• Online 
• Query 
• Results 
• Preferences 
• Web 
• Window  
• Help 

 
File Menu  

The File Menu in STN Online and Results Window contains the following:  

• New (Logon) 
• CAS Registry BLAST 
• Open 
• Close 
• Table Tool 
• Report Tool 
• BLAST Report with Alignment Data 
• R-group Analysis Table Tool 
• Create Analyze Plus Chart from saved data 
• Edit Personal Dictionary 
• Edit Data Group File 
• Predefined Reports 
• Save 
• Save As 
• Save Selected 
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• Edit Text File 
• Page Setup 
• Print Selected 
• Printer Setup 
• View TIFF image 
• Convert STN AnaVist .rkx file (V.1 - V1.1+) to .xta file (V.2.0+) 
• Exit STN Online and Results 

 
Edit Menu  

The Edit menu in STN Online and Results window contains the following: 

• Undo 
• Cut 
• Copy 
• Paste 
• Clear 
• Select All 
• Create Query File  - to create query structures from structures in transcripts 
• Show Clipboard 
• Install Dictionary - to create a list of terms to be highlighted in a transcript 
• Edit Dictionary - to edit a list of terms to be highlighted in a transcript 
• Find 
• Replace 
• Goto 
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Online Menu  

The Online menu in STN Online and Results window contains the following: 

Online Menu Option Function 
Recall Command  Recall the last command you typed online. 

You may use this command repeatedly to 
recall prior commands from the same 
session, or to edit a line to create a new 
command.  Use the Up Arrow/Down Arrow 
keys as shortcuts. 

Use Pagination Mode/ Use Continuous 
Scroll  

Toggle to control the scrolling of your online 
display data. Pagination Mode holds a 
screen temporarily. To continue displaying 
the next screen, click the Hold On box in 
the Status Bar. 

Show Text Structures/ Show Graphics 
Structures  

Toggle to display text or graphics structures. 

Suppress Screen Display/ Restore Screen 
Display 

Toggle to control the output display in a 
terminal window. Suppress Screen Display 
prevents STN Express from updating the 
window with new data; this increases the 
speed at which you may capture results. 

Send Break  Send a break to interrupt a host system 
process. 

Prompt Override  Moves your cursor to the line directly below 
the prompt and makes STN Express ready 
to accept a typed command. 

Terminal Mode  Use to change terminal emulation if you 
want to access non-STN hosts. 

Kermit Send  Upload text or binary files using the Kermit 
protocol. 

Kermit Receive  Download a file from a host system. 
Logoff  Disconnect from an online host. 
Logoff Hold  Disconnect from STN temporarily.  
Command Window  Open a separate window for entering 

commands to your online host. 
Wizard Window  Display the Wizard Window. 
Look up in personal dictionary Look up terms in personal dictionary search 

aid. 
Look up in Lexicon dictionary  Look up terms in CA Lexicon search aid. 
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Query Menu  

The Query menu in STN Online and Results window contains the following: 

• Upload Structure Query 
• Generate WPI Strategy 
• Prepare Command File 
• Check Command File 
• Run Command File 
• Create Command File from SciFinder Answer Keys 
• Create and Run Command File from SciFinder Answer Keys 
• Create Search Term Command File 
• Create Query Summary File 

 
Results Menu  

The Results menu in STN Online and Results window contains the following: 

• Capture Session 
• Print Session (Slave) 
• Start New Page 
• Edit Transcript 

 
Preferences Menu  

Preferences menu in STN Online and Results window opens Preferences tabs for: 

• Function Keys 
• Online 
• Colors/Fonts/Scaling 
• Links 
• Layout 
• Discover! 
• Accounting 
• Postprocessing 
• Other  
• User Data 
• BLAST 
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Web Menu  

The Web menu In STN Online and Results window contains connections to services from: 

• STN Columbus 
• STN Karlsruhe 
• STN Tokyo 

 
Window Menu  

The Window menu in STN Online and Results window contains the following options for 
managing the appearance of the STN Online and Results window: 

• Cascade 
• Tile Horizontal 
• Tile Vertical 
• Arrange Icons 
• Close All 

 
Help Menu  

The Help menu in STN Online and Results window contains the following: 

• Help to view the help topics 
• View STN Express User Guide 
• Request Help 
• Update Discover! Database List 
• About STN Online and Results 
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STN Online and Results Toolbar 

The Toolbar in STN Online and Results window contains the following buttons. Hover the cursor 
over the button to have its function displayed in the Status Bar. 

Toolbar Function 

 
Logon 

 
Launch BLAST 

 
Open 

 
Edit transcript 

 
Turn off capture session 

 
Print 

 
Copy 

 
Paste 

 
Report tool 

 
Table tool 

 
Predefined Report and Table tool 

 
R-group tool 

 
Go backwards in a session or transcript 

 
Go forward  in a session or transcript 

 
Upload structure query 

 
Open Discover! Wizard Window 

 
Activate the Command Window 

 
Prepare the Command File 

 
Run the Command File 

 
Send break to online host 

 
Hyperlink all CAS Registry Numbers® while connected to STN 
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Toolbar Function 

 
Send logoff command  

 
Force send - click, enter your command and press Enter 

 
Open structure drawing window 

 
Set various Terminal Emulation preferences 

 
Help 

 

You may customize the Toolbar by adding or removing tool buttons. 

To add a tool button:  

1. Right-click in the space on the Toolbar where you want to add a button.  The Toolbar 
Preferences dialog appears.  The initial option is Remove button or gap from toolbar. 

2. Click Next to view the buttons one at a time.  Continue to click Next until you see the 
desired button. 

3. Click OK to choose the displayed button for the Toolbar. The new button is displayed on 
the Toolbar in the slot you have selected. 

To remove a tool button or a gap: 

1. Right-click on the button or gap that you want to remove.   
2. In the Toolbar Preferences dialog, click OK. The tool button or gap that you have 

selected is now removed from the Toolbar. 
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Status Bar in STN Online and Results Window 

The Status Bar in STN Online and Results window contains the following: 

Status Bar 
Item  

Function 

Discover!  Displays a pop-up menu for the Discover! wizards. 
Transcript    Displays the directory path and the file name for your transcript.  If you 

are not capturing a transcript, click Transcript to start capture. 
File Name   Displays the current STN file. Click this box to display a pop-up menu 

with recently entered files or to select From a List of files. 
INS/OVR    Click this box to change from the insert to overwrite mode for entering 

text. 
Hold On/Hold 
Off  

Toggle to Hold On to stop the screen from continuously scrolling. 
Toggle to Hold Off to resume scrolling. 

Print Off/Print 
On        

Print On activates slave printing of information on the terminal window. 
Print Off turns off printing. 

Online 
                         

Indicates an active session; the green color indicates ready and red 
indicates busy. Offline indicates terminated communication.  

Running Timer  Displays the total amount of time you have been connected in your 
online session. 

Refer to Layout Preferences for information on how you can customize the Status Bar. 
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Transcripts 

Transcripts Overview 

The following topics are covered in this section: 

• Browsing  transcripts 
• Printing transcripts 
• Viewing images in transcripts 
• Exporting transcripts 
• Modifying transcripts with transcript filters 
• Customizing highlighting in transcripts 
• Combining transcripts 
• Saving transcripts 

 
 
Browsing Transcripts 

To browse a captured transcript: 

1. Select Browse Transcript from the Results menu on the Main Menu bar, or click 
Browse Transcript on the Toolbar.  

2. In the Transcript File dialog, select a file name from the list and click Open.  
3. The Show structure queries option is selected. Deselect this option if you do not want 

to have structure queries included in the transcript. 
4. If your transcript contains downloaded images, i.e., TIFF, GIF, or JPEG images, answer 

the prompt whether to view them in context. 

The selected transcript file opens for browsing. 

 
 
Printing Transcripts 

To print a transcript while browsing it, click the Print button on the toolbar or select Print from the 
File menu. 

To print a transcript from the Main Menu window: 

1. Select Print Transcript from the Results menu or from the Main Menu Toolbar.   
2. In the Transcript File dialog, select the file for printing and click Open.   
3. Select the specifications in the Page Layout dialog and enter any specifications for your 

printer. 
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Viewing Images in Transcripts 

While you are browsing or printing transcripts, TIFF, GIF, or JPEG downloaded images are 
displayed in context if you answer Yes to the prompt Display image files in context?  

To display TIFF images separately from the transcript text: 

1. Select View TIFF image from the File menu. 
2. A list of TIFF files is displayed in the TIFF File dialog.  Select the TIFF file you want to 

display. 

 
 
Exporting Transcripts 

To export a transcript file to an RTF (Rich Text Format) file: 

1. Select Export Transcript from Results on the Main Menu. 
2. In the Transcript File dialog, select a transcript file and click Open.  
3. In the RTF File dialog, the transcript name is displayed in the File name box with the .rtf 

extension.  By default, the file is saved to the default transcripts folder, but you can direct 
it to any location on your PC.  Click Save.   

 
 
Modifying Transcripts with Filters 

You may easily modify an existing transcript using transcript filters. STN Express offers five 
predefined filters. You may also define your own filters. 

To modify your transcript with transcript filters: 

1. Click Browse Transcript. 
2. In the Transcript File dialog, select the transcript you want to modify (e.g., express1.trn) 

and click Open. 
3. In the STN Online and Results window, select File > Transcript Filters.... 
4. In the Transcript Filters dialog, type the name that your modified transcript will have (e.g., 

express2.trn). Click Save. 
5. In the Specify Filter dialog, load a predefined filter from the Load Filter drop-down menu. 

Predefined Filter Result 
stn-ans Transcript with only answers  
stn-cmd       Transcript with only STN commands 
stn-cmdh       Transcript with only STN commands and their results, 

excluding reactions 
stn-strs     Transcript with only structure graphics 
stn-tifs   Transcript with only TIFF images 
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Alternatively, define a custom transcript filter. In the Specify Filter dialog, enter this 
information to define the filter: 

Field Description 
Filter name Name for the transcript filter. 
Start string String that starts the filter. For example, RL.NP. 

Click Add to add the string to the filter. 
End string String that ends the filter. For example, REFERENCE. 

Click Add to add the string to the filter. 
Default  

• Include All 
Fields 

• Exclude All 
Fields 

By default, include or exclude all fields between the start and 
end strings. Include All Fields is the system default. 

Exceptions One or more exceptions to the fields to be included or 
excluded between the start and end strings. 

Click Add to add the exception field(s) to the string. 

6. Click OK.  

If you defined a custom filter, the next time you access the Specify Filter dialog, the name 
of that filter should be selectable from the Load Filter drop-down menu. 

 
 
Customizing Highlighting in Transcripts with Dictionaries  

To create a list of terms to be highlighted in a transcript: 

1. Select Browse Transcript and open a transcript.  
2. To create a dictionary file with your list of terms, select Edit Dictionary from the Edit 

menu. 
3. In the Dictionary File dialog, click New to create a new dictionary file. 
4. In the Edit Dictionary dialog, type a term that you want highlighted in your transcript.  

Click Add to add it to the dictionary file.  Continue adding up to 10 terms.  Terms are 
listed in alphabetical order and are not case-sensitive.  Click the color in which you want 
the terms highlighted.  Click OK.   

5. Save the dictionary file at the next prompt.  
6. To apply the dictionary, select Install Dictionary from the Edit menu.  
7. In the Dictionary File dialog, select the dictionary file to apply.  Click Open.  

The selected dictionary file is applied to the current transcript, i.e., the terms that you have added 
to the dictionary file are now highlighted by displaying them in the color that you have selected. 
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Combining Transcripts 

To merge multiple transcript files into one file: 

1. Select Browse Transcript and open any transcript file. While the transcript file is open, 
select Combine Transcripts from the File menu. 

2. The Combine Transcripts dialog is displayed.  Type a new file name in the File name box. 
Click Save.  

3. The Select Transcripts to Combine dialog is displayed.  Select a file that you want to 
combine and click Copy.  The file is moved to the Selected Transcripts box.  Select 
another transcript and click Copy.  You may merge as many files as you like.  Click OK 
to create the merged file.  

 
 
Saving Transcripts 

While you are browsing a transcript, you may save it as an RTF (Rich Text Format) or PFD 
(Portable Document Format) file:  

1. Select Save As from the File menu. The Enter Filename dialog opens with the transcript 
name as the default name in the File name box.  

2. Select RTF Files (*.rtf) or PDF Files (*.pdf) in the Save as file type: field. 
3. Click Save. 

For RTF files, the saved transcript automatically opens in the program associated with .rtf 
documents.   

Tip:  If a saved .rtf file is slow to open, change it to a .doc file so it will open faster.  
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Wizards 

Using Discover! Wizards 

STN Express provides access to wizards that support you in using unfamiliar or rarely used 
functions and provide increased efficiency for multistep processes. 

You can access the Discover! wizards from:  

• The Select Discover! Wizard window    
• The Discover! button at the bottom of the STN Online and Results window 

To use any of the Discover! Wizards, select the wizard and follow the directions on the screens 
step-by-step. 

 Search and Results wizards in the Select Discover! Wizard window 

Search wizard  Function 
Select Database  Selects a database on STN 
Author  Finds references by author (including inventor) name in the current 

file(s) 
Chemical Name  Locates information about a substance by using its chemical name 
Subject  Finds references by subject area 
Edit Alert  Modifies an existing current-awareness alert (SDI) 
Upload Query  Uploads sequence or structure to STN 
Corporate 
Source  

Finds references by corporate source (author or inventor affiliation) in 
the current file(s) 

Refine Refines search results by parameters such as publication year or 
language 

CAS Registry 
Number  

Locates information about a substance by using its CAS Registry 
Number in the current file(s). 

Get Related 
Polymers  

Searches for related polymers 

Get Related 
Sequences  

Searches for related sequences  

Create Single-
file SDI 

Creates current-awareness alerts (SDI) in a single file 
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Results wizard  Function 
Analyze Plus  Analyzes, groups, cross-tabulates, and creates an interactive 

worksheet of terms from one or two fields of an answer set  
Analyze  Analyzes and charts terms from one or two fields of an answer set (no 

grouping of data)  
Display  Displays retrieved answers 
Go to L-number  Displays the search statement for the L-number  
Save  Saves answers, queries, or L-numbers on STN.  
Save R-group 
Data  

Saves R-group data for displaying in R-group Analysis Table  

Review Saved 
Items 

Displays, deletes, or assigns L-numbers to saved items 

Save for 
SciFinder  

Saves the data from a search in CAplusSM, REGISTRY, or MEDLINE 
for use in SciFinder 

Save for STN 
AnaVist 

Saves the data from a search in supported files for use in STN AnaVist 

Create CAS 
Registry 
Numbers & Role 
Report  

Creates an interactive spreadsheet of CAS Registry Numbers and their 
CAS Roles from a search of the CA/CAplus database or CAS 
REGISTRYSM 

Create L# from 
STN AnaVist 

Uses a Saved for STN AnaVist .xta file to create a final L-number that 
has all the functionality of an L-number created by using the STN 
SEARCH command 

Display from 
STN AnaVist 

Displays records saved in STN AnaVist 2.0  

Evaluate with 
STN Viewer  

Sends patent records for evaluation with STN Viewer  

Patent Family 
Manager 

Creates a new L-number from the first member from each patent family 
and/or allows for customized display of patent family results 
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Wizards available from the Discover! button 

Wizard Function 
Set Loginid Parameters Sets various parameters for your online session  
Select a Database... Selects a database on STN 
Search by... Search by AU, CAS RN, CS, and other terms 
Upload Sequence or 
Structure to STN 

Upload Sequence or Structure to STN 

Display by Display by Answer or Accession Number 
Analyze Analyze or Analyze Plus wizard 
Create CAS RN and Role 
Report 

Creates an interactive spreadsheet of CAS Registry 
Numbers and their CAS Roles from a search of the 
CA/CAplus database or CAS REGISTRYSM 

STN AnaVist Lets you choose these wizards: Save for STN AnaVist, 
Display from STN AnaVist, or Create L# from STN AnaVist 

Patent Family Manager Creates a new L-number from the first member from each 
patent family and a customized display of patent family 
results 

Evaluate with STN Viewer  Sends patent records for evaluation with STN Viewer  
Get Related Searches for related polymers or sequences 
SDI Creates or edits an SDI alert 
Save Saves answers, queries, or L-numbers on STN  
Display Session Costs Display Session Costs 
Logoff Your STN Session Logoff Your STN Session 
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Wizards for Hyperlinked Terms 

To make it easy to retrieve additional information, L-numbers, CAS Registry Numbers, and Patent 
Numbers in STN search results are hyperlinked.  Click on the hyperlinked item to display a list of 
associated wizards.  

Hyperlinked item   Associated wizards and functions 
L-number for answer 
sets 

• Analyze Plus 
• Analyze 
• Display 
• Refine  
• Save  
• Save for R-group Analysis 
• Save Answers for SciFinder 
• Save for STN AnaVist 
• Single File SDI 
• Get Related Polymers 
• Get Related Sequences 
• Create CAS RN and Role Report 
• Patent Family Manager 
• Evaluate with STN Viewer 

CAS Registry Number Retrieve additional information for CAS Registry Numbers: 

• Get CAS REGISTRYSM data 
• Get Catalog data 
• Get Regulatory data 
• Get MSDS data 
• Get Spectra  
• Get Property data 
• Structure search 
• Get Related Polymers 
• Get Related Sequences 

Patent Number Retrieve additional information for patents: 

• Evaluate with STN Viewer 
• Get Patent from CAS Full Text Options 
• Get Legal Status 
• Get English Language Equivalents 
• Get Extended Patent Family Information 
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Analyze Plus Wizard 

Using Analyze Plus 

The ANALYZE PLUS wizard is used for: 

• Analyzing terms from one or two fields of answer set 
• Grouping data before charting 
• Cross-tabulating and charting of analyzed terms 
• Producing an interactive Microsoft Excel worksheet of analyzed terms 
• Cross-tabulating and charting terms resulting from the ANALYZE command 

To use the ANALYZE PLUS wizard: 

1. Conduct a search in one or more databases 
2. Select the answer set and click Analyze Plus. 
3. Select one or two fields to be analyzed (the default is two fields).  Group similar terms is 

checked by default. 
4. Click Options to customize the display of terms. 
5. Click OK to return to the Analyze Plus Wizard window.  Click Analyze. 
6. The Data Group Tool is displayed.  See Data Grouping for details.  Click Finish when 

you are done. 

STN Express cross-tabulates your data and displays it in a Microsoft Excel worksheet.  Click the 
3-D Column tab near the bottom left of the window to view the analyzed terms as a chart.  Click 
Cross-tab to return to the cross-tabulation view.  A second Microsoft Excel worksheet is also 
created.  To display it, select the other worksheet from the Window menu.  This worksheet 
contains the raw data that can be manipulated by standard Microsoft Excel features. 

Related topics: 

• Charting Terms from the ANALYZE Command 
• Creating Charts from Saved Tabulated Data  
• Displaying Records from Analyze Plus Charts 
• Data Grouping 
• Editing Data Groupings 
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Data Grouping in Analyze Plus 

When using the Analyze Plus Wizard, similar terms from the Author/Inventor Name, Corporate 
Source/Patent Assignee, and Company Name fields are automatically grouped by the wizard. To 
customize the groupings, select the terms in the window and click one of the options on the right. 
You may alternatively drag-and-drop terms for grouping. Check Save changes to data 
groupings if you want to save the groupings for editing or exporting. Click Next.  

Data Grouping 
Option 

Explanation 

Show all included 
terms 

Display all terms included in analysis. 

Show included 
grouped terms 

Display only grouped terms that will be included in analysis. 

Show ignored terms Display only terms that you selected to be ignored in analysis. 
Rename Assign a different name to the selected term or group of terms. 

This is the name that will be used for this group of terms in the 
Microsoft Excel worksheet. 

Ignore  Ignore selected terms, i.e., do not include the ignored terms in 
analysis. 

Group Group selected terms. The first term will become the name of the 
group. 

Ungroup Ungroup selected terms. The selected terms will be removed from 
their groups and will become individual terms. 

Ungroup All Ungroup all terms. All terms will become individual terms. 
Regroup All Restore the grouping that existed when this window was first 

displayed.   
Expand All Display the members of all groups. 
Collapse All Show only the name of each group. 
Undo Undo the last action performed in the Data Group Tool window. 

Undo can be used multiple times to reverse a series of actions. 
Redo Re-apply the change that was most recently undone. Redo can be 

used multiple times to re-apply a series of actions that have been 
undone. 

If terms are not grouped automatically, you may group them manually.   
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Editing Data Groupings of the Analyze Plus Wizard 

Editing of data groupings is possible only if the grouping is saved. To save data groupings, check 
Save changes to data groupings in the Data Group Tool window of the Analyze Plus Wizard. 

To edit data grouping after exiting the Analyze Plus Wizard:  

1. Select Edit Data Group File from the File menu of STN Online and Results window. 
2. In the Select Data Group File window, select the file to be edited and click OK.    
3. Edit the selected grouping in the Data Group Tool Editor. 

To edit data groupings after logoff, you have to get to the STN Online and Results window first. 
One way is to select Open from Results on the Main Menu of STN Express and click Cancel in 
the Choose File window.    

 
Creating Charts from Saved Tabulated Data 

To create charts after exiting STN Express or exiting the STN Analyze Plus Wizard: 

     1.   Check Capture delimited tabulation data for later use in the Analyze Plus Wizard  
            window.  

     2.   Save the tabulated data as a .tbn file in the Uscripts (default) or another folder.  

To create charts from saved tabulated data:  

1. Exit the Analyze Plus Wizard or logoff from your online session.  
2. From the File menu in the STN Online and Results window, select Create Analyze Plus 

chart from saved data.    
3. In the Uscripts folder select the name of the saved .tbn file and click Open.  
4. Follow the steps to create Microsoft Excel charts and sheets described in Using Analyze 

Plus. 

 
Charting Terms from the ANALYZE Command 

To use the Analyze Plus Wizard to chart terms that have already been analyzed with the 
ANALYZE command:  

1. Select the L-number created by the ANALYZE command, and click Analyze Plus. 
2. Select one or two fields for charting.  Click the Options button to customize the display, 

or click Analyze if you are ready to proceed.  The wizard guides you through the same 
steps shown for Using Analyze Plus.  
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Displaying Records from Analyze Plus Charts 

To display STN records associated with a specific cell, double-click the cell. To display records 
associated with multiple cells, select the cell(s) and click Display Records from the toolbar. 

To display STN records from the 3-D column view, double-click a column.  

Choose your display options. Click Display. 

STN Express displays the requested answers in a separate window.  

 
 
Analyze Wizard 

The Analyze Wizard is used for: 

• Analyzing terms from one or two fields of an answer set 
• Charting of analyzed terms  

To use the Analyze Wizard: 

1. Conduct a search in one or more databases. 
2. Select the answer set and click Analyze.   
3. Select one or two fields to be analyzed.  Click Options for additional customizing of 

results. 
4. Use Options to customize the display of terms. Click OK to return to the Analyze wizard 

window.  Click Analyze.  

Non-interactive charts are created. 

 
 
Patent Family Manager Wizard 

The Patent Family Manager wizard is available starting with STN Express Version 8.4.  The 
wizard may be used to: 

• Extract the first member from each patent family and create a new L-number 
• Create a display of patent family results 

The Patent Family Manager wizard works on L-number answer sets: 

• From one or more files 
• Containing up to 5,000 answers 
• Containing patent documents as well as non-patent literature 

You may launch the Patent Family Manager from the Results tab of the Select Discover! Wizard 
Window, or from the Discover button, or from an L-number hyperlink.      
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To extract the first member from each patent family: 

1. Select the appropriate L-number for your answer set by choosing it from the Search 
history in the Select Discover Wizard window or the answer selection window if you 
launched the wizard from the Discover button menu options.  

2. In the Patent Family Wizard window select the option to extract the first member from 
each patent family.  Check the box if you want to include non-patent answers as well. 
Click Extract.  

STN Express automatically executes commands to create a new L-number that contains only the 
first member from each patent family.  The commands that are executed are automatically 
displayed.  A confirmation message is displayed in a box when the L-number has been created.  

Click OK. Click Finish to exit the wizard.  

To create a display of patent family results:  

1. In the Patent Family Wizard window select the option to customize display of patent 
family results.  Enter a display format for first member of each patent family.  Enter a 
display format for additional members of each patent family.  You may also check the box 
for inserting a page break between each patent family.  Click Display if you want 
answers to be displayed. Requested answers are displayed in your online session as well 
as in a separate window.  

2. Click Finish to exit the wizard.  

 
 
Creating a CAS Registry Number and Role Interactive Spreadsheet 

Use the CAS Registry Number and Role Report Wizard to obtain an overview of the relationship 
of the compounds in your answer set and the types of studies for those compounds.  You can 
analyze CAS roles for:  

• All the CAS Registry Numbers in your answer set, or  
• Only the hit CAS Registry Numbers in your answers set.   

You may launch the CAS Registry Number and Role Report from the Results tab of the Select 
Discover! Wizard Window, from the Discover button, or from an L-number hyperlink. 

To create a spreadsheet from CAS Registry Numbers and CAS Roles:   

1. Conduct a search in the CA/CAplus database or CAS REGISTRYSM.  
2. Select the Create CAS RN & Role Report wizard and the L-number for the answer set.  
3. Select All RNs and the answers to be used. Click Chart.  

The CAS Registry Numbers from the selected documents and the associated roles are tabulated 
in a Microsoft Excel interactive spreadsheet.  Click 3-D Column on the bottom of the sheet to 
view the data as a 3-D column.  
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To create a report from Hit CAS Registry Numbers and CAS roles  

1. Conduct a search in the CA/CAplus or CAS REGISTRY database.   
2. Select the CAS RN & Role Report wizard and the L-number for the answer set.  
3. Select Hit RNs and the answers to be used. Click Chart.   

To display answers from a CAS RN & Role Report:   

1. To display STN records associated with a specific cell, double-click the cell.  To display 
records associated with multiple cells, select the cell(s) and click Display Records from 
the toolbar. To display STN records from the 3-D column view, double-click a column.  

2. Choose your display options.  Click Display.  Selected answers are displayed in both 
your online session and in a separate window.  

 

 
STN® AnaVistTM Wizards 

Save for STN AnaVist 

The Save for STN AnaVist Wizard saves the data from a search in supported files for use in STN 
AnaVist. 

To use the Save for STN AnaVist Wizard: 

1.  Conduct a search. One or more of the supported databases may be searched together or 
separately, before saving and importing documents into STN AnaVist: 

• CAplus family of databases  
• EPFULL 
• PCTFULL  
• USPATFULL and USPAT2  
• Derwent World Patents Index® (DWPI  database (WPINDEX, WPIDS, and WPIX  files on 

STN with access to WPIDS and WPIX for subscribers only)  
• 2ANAVIST cluster: includes CAplus, EPFULL, PCTFULL, USPATFULL, USPAT2, and 

WPINDEX/WPIDS/WPIX  
• 2HANAVIST cluster: includes HCAplus, EPFULL, PCTFULL, USPATFULL, USPAT2, and 

WPINDEX/WPIDS/WPIX  

2.  Select the Save for STN AnaVist wizard in one of the following ways:  

• Click on the L-number answer set that you want to transfer to STN AnaVist.    
• Click the Discover! button and highlight the L-number with the records.  
• Select from the Select Discover! Wizard window and select the L-number with the 

records. 

The wizard guides you to save the answers in STN Express or to send them as an email 
attachment.   
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Display from STN AnaVist 

In STN Express 8.2 or higher you can view documents exported from STN AnaVist 2.0.  

These documents need to be saved in STN AnaVist 2.0 in eXpress to AnaVist (.xta) format.  

To use STN Express 8.2 or higher to display documents saved in STN AnaVist, select the 
Display from STN AnaVist wizard from the Results tab of the Select Discover! Wizard screen 
and follow the step-by-step directions.  

 
Create L# from STN AnaVist for Evaluating with STN Viewer 

In STN Express 8.3 or higher you can use a Saved for STN AnaVist .xta file to create a final L-
number that has all the functionality of an L-number created by using the STN SEARCH 
command.  If the input .xta file contains answers from multiple STN files, a separate L-number is 
created for each of the STN files. 

The L-numbers created from STN AnaVist may be imported to the STN Viewer using the 
Evaluate with STN Viewer wizard.  

To create an L-number from an STN AnaVist .xta file, select the Create L# from STN AnaVist 
wizard from the Results tab of the Select Discover! Wizard window and follow the step-by-step 
directions.  

 

Evaluate with STN® ViewerTM 

In STN Express 8.2 or higher you can send patent documents to STN Viewer for evaluation.   

To send one patent for evaluation with STN Viewer: 

1. Click on the patent number in a displayed answer 
2. Select Evaluate with STN Viewer from the options.   

To send an answer set for evaluation with STN Viewer: 

1. Click on an L-number or highlight the L-number in the Select Discover! Wizard window 
2. Select Evaluate with STN Viewer. 

You can also access the Evaluate with STN Viewer wizard from the Discover! button. 

In STN Express 8.3 or higher you can also use the Create L# from STN AnaVist wizard to 
create an L-number for import into the STN Viewer.  



Online Search Aids 

Online Search Aids 

Personal Dictionary Search Aid 

STN Express can automatically create a "personal dictionary" consisting of an alphabetical listing 
of any terms that you have used in your search statements. You may then use this personal 
dictionary to save time in query development by selecting hard-to-spell or other terms.  

To create and use a personal dictionary, check the box Create and update personal dictionary 
in the Online tab of Preferences. Your personal dictionary will continue to be updated until you 
click Clear Dictionary in Online Preferences.  

To use personal dictionary: 

1. Start typing in SEARCH or EXPAND command. 
2. Select Lookup in personal dictionary from the Online menu. 
3. A separate window appears with an alphabetical listing of terms in your personal 

dictionary.  Double-click on the desired term. 
4. The selected term may be used in your SEARCH or EXPAND statement. 

To edit personal dictionary:  

1. Select Edit Personal Dictionary from the File menu in STN Online and Results. 
2. The Personal Dictionary Editor window is displayed with editing options.  

Option  Function 
Add Add a term from the single line text box to the dictionary 
Replace  Replace the selected term in the dictionary by the term in the single line 

text box 
Delete  Delete selected term(s) from the dictionary 
Import  Import terms from an exported personal dictionary (.txt) file for adding to 

the current personal dictionary 
Export Export a copy of the personal dictionary as a plain text (.txt) file for 

sharing 
Clear Clear (remove) the content of personal dictionary 
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CA Lexicon Search Aid 

STN Express makes it easy to use the CA Lexicon terminology in CAplus and CA files on STN. 

In the CA or CAplus file, when you enter a search term that is in the CA Lexicon, STN Express 
automatically highlights the term in a yellow box. That default is set in the Online tab of 
Preferences. You may also select a wavy purple underline for identifying any of the CA Lexicon 
terms in your search statements. 

To add CA Lexicon terms to your search profile: 

1. Enter a search term in CA or CAplus.  If the term or phrase is in the CA Lexicon, it is 
highlighted in a yellow box.  Right-click on the highlighted term to view the CA Lexicon 
entries. 

2. CA Lexicon entries for the highlighted term are listed in a separate CA Lexicon display 
window. The CA Lexicon feature does not work in the command window. The CA Lexicon 
terms are the results of the following STN interaction: EXPAND term+ALL/CT. Select the 
terms to include in your search strategy. Select the Boolean operator (AND, OR). 
Uncheck the box Use parentheses, if you do not want parentheses to be automatically 
included.  Click Add Terms. Close the CA Lexicon display window.  

3. Press the Return key to execute the search with the CA Lexicon terms included.  Note 
that the CA Lexicon terms are searched in the Basic Index.  You may change the search 
field or add more terms to the search profile, before you press the Return key. Make sure 
that the CA Lexicon display window is closed when you are finished using the CA 
Lexicon. If you press Return while the CA Lexicon window is still active, the selected CA 
Lexicon terms will be added again.  

To use CA Lexicon to complete search terms: 

1. Start typing a term in the SEARCH or EXPAND command. 
2. Select Look up in Lexicon dictionary from the Online Menu. 
3. Lexicon terms appear in a separate window. This feature does not work in the command 

window. Double-click the term that you want to use in your SEARCH or EXPAND 
statement. The term is automatically completed. 



Structure Searching Overview 

Structure Searching Overview 

 
Structure Searching Steps 

1. Build the structure offline.  Select Prepare Structure Query from the Query menu or 
click the Prepare Query button on your Toolbar. The Structure Drawing window opens. 
Use the structure tools and menus to build your structure. You may also create your 
structure from a transcript.  

2. Save the structure by selecting Save from the File menu.  
3. Select Exit from the Structure Drawing File menu to return to the Main Menu. 
4. Log on by selecting the Logon button or Logon from the Main Menu. 
5. Upload the structure by selecting Upload Structure Query from the Query menu. 
6. An L-number for the uploaded structure is created.  Use that L-number for searching.  

 

Structure Drawing Window 

The Structure Drawing Window contains: 

• Structure Drawing Menu Bar - at the top of the Structure Drawing window 
• Standard Toolbar - at the top of the Structure Drawing window 
• Vertical Tool Palette - on the left side of the Structure Drawing window 
• Horizontal Tool Palette - on the bottom of the Structure Drawing window 

 
 
Uploading Structures 

Select Upload Structure Query from the Query menu or click the Upload button to select, 
preview, and upload a structure query for searching. To upload multiple structure files with one 
command, use the Ctrl or Shift key to select multiple files in the File Open dialog. 

Check Modifiable queries if you want to be able to modify your query using STN commands. 

Use Filters is automatically checked if you used filters (screens) to refine your structure query.  
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Creating Structure Search Queries from Transcript 

To create a searchable structure from a transcript structure: 

1.   Select Browse Transcript from the Main Menu Toolbar. Open the transcript containing the 
captured structures. 

2.   Highlight the structure diagram in the open transcript.  Select Create Query File from the 
Edit menu.  

3.   Click OK when the Create Query File message is displayed.  

4.   In the Structure File dialog box, type the name that you want to assign to the structure.  Click 
Save.  

5.  To recall the saved structure, select Prepare Structure Query from the Query menu, or click 
Prepare Query on the Main Menu Toolbar.  Then select Open from the File menu to open 
the saved structure.  

The structure diagram is displayed in the Structure Drawing window 

 
 
Using Filters (Screens) to Refine Structure Queries 

You may refine a structure query by using filters (screens). Filters are useful  

• to make your query run more efficiently online 
• to allow you to run some queries that would normally exceed the system limits 
• to specify non-structural aspects of your query. 

To add filters: 

1.   Select Save from the File menu or click the Save tool when you are done with creating your 
structure in the Structure Drawing window. 

2.   Check Refine Using Structure Filters and click Save in the Saving dialog.   

Refine Using Structure Filters window is displayed.  Any filter automatically selected by STN 
Express is displayed preceded by >> in the selected filter list box. Other filters can be added 
by selecting the filter from the list, followed by the operator that you want to use. Any CAS 
REGISTRY file screen number can also be added to a Custom Screen list. 

Click Save when you are done. 

3.   Logon to STN and upload the structure.  Use Filters is automatically checked in the Structure 
File window.  Click Open to upload the structure.  A command file is automatically run.  L-
numbers are created for the screens as well as the structure, and a final L-number query 
consisting of the structure and screens is created.  Conduct the search using the query L-
number
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Structure Drawing Tools 

Vertical Tool Palette 

Vertical Tool Palette Content 

The Vertical Tool Palette, containing structure drawing tools, displays on the left side of the 
Structure Drawing window.   

To use a tool: Click an icon and the cursor changes accordingly. 

General drawing tools on the Vertical Tool Palette include: 

• Pencil Tool (default selection) 
• Ring Tool 
• Chain Tool 
• Eraser Tool 
• Selection Tool 
• Lasso Tool 
• Text Tool 

The following tools are for reaction searching only:   

• Reaction Arrow Tool 
• Reaction Role Tool 
• Reaction Site Tool 
• Atom Mapping Tool 
• Functional Group Tool 
• OR Tool for Functional Groups 

 
Pencil Tool 

This is the default drawing tool; it is used to draw or change atoms and bonds. 

Point the pencil cursor and click once to draw a C atom. Carbon is the default Current Atom 
value. Click, hold, and drag the mouse to the point you want another C node to appear and 
release the mouse; a second atom is drawn connected to the first by a single bond (the default 
Current Bond Value).  

Modify an existing atom or bond by selecting a new value and then pointing to the atom or bond 
and clicking. For example, click on the O and then on the double bond in the Horizontal Tool 
Palette at the bottom of the drawing screen. Point to an existing C and click to modify it to an O 
and then point to an existing single bond and click to modify it to a double bond. 

Notice that the pencil cursor changes to display an "A" or "--" when pointing to an atom or bond. 
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Ring Tool 

The Ring Tool can be used to draw various ring systems: 

To draw isolated rings:  

1. Type the ring size that you want in the Ring Description box, or use the scroll bar to 
display ring sizes available. 

2. Place the ring cursor where you want the ring and click.  The ring is drawn vertically 
upwards from the cross in the center of the cursor, using the current atom type but not 
the current bond type.  Resent the current atom to C before using the Ring Tool. 
Additional rings of the same type will be drawn on subsequent clicks. The saturated and 
unsaturated rings displayed in the Ring Tool dialog can be selected directly by pointing to 
them and clicking. 

To draw fused rings:  

Rings can be fused, with an appropriate ring size selected, by pointing to an existing ring atom for 
spiro fusion, or to the middle of an existing ring bond for fusion along that bond. 

Note: The cross in the center of the cursor is the "active point" for ring fusion, and the cursor 
changes when positioned over an atom or bond (displaying an "A" or "--"). Fused ring systems, 
consisting of 6, 5, or 4 membered rings, can also be typed into the Ring Description box in the 
Ring Tool dialog. The direction of fusion is left to right, the direction can be changed from 
horizontal using "U" or "D" for up or down. For example, 66U6D5 draws a steroid skeleton. 

Shortcuts 

Click right on the Ring Tool to select the default ring system. Also, click right in the drawing area 
to place alternating single and double bonds for the default ring system.  

 
Chain Tool 

Use the Chain Tool to draw zigzag chains with the current atom and bond type. The default chain 
length is 1. Type the length you want into the Chain Length dialog or use the scroll bars to select 
the length. Chains are drawn from left to right (or in an otherwise chemically logical direction) 
from the arrowhead on the chain cursor. 

Shortcuts 

Click right on the Chain Tool to select the default chain length. 

 
Eraser Tool 

Use the Eraser Tool to delete an atom or bond.  

To delete a node, click the Eraser Tool, place your cursor on the node that you want to delete, 
and click.  The node and all bonds attached to it are removed. 
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To delete a bond, click the Eraser Tool, place your cursor on the bond that you want to delete and 
click.   

If Delete Atoms with Bonds is checked in the Drawing tab of Structure Preferences, the atoms 
at either end of a bond will be deleted when a bond is deleted, assuming there are no other 
attachment to the atoms.  

Use the Selection Tool and Cut from the Edit menu for multiple deletions. 

 
Selection Tool 

The Selection Tool is used to select atoms or bonds for subsequent operations. Point to the atom 
or the middle of the bond and click.  

To deselect an atom or bond, click on an empty space in the drawing window.   

Hold the shift key down to make multiple selections; alternatively click, hold, and drag to draw a 
rectangle around a fragment to select all atoms and bonds within that rectangle. 

 
Lasso Tool 

Use the Lasso Tool to select and move part of a structure: 

1.  Click, hold, and drag the lasso around the fragment that you want to move. 

2.  Move the lasso cursor into the lassoed area so that it changes to a hand cursor. 

3.   Click, hold, and drag the fragment to a new position. 

An individual atom or shortcut can also be moved: 

1.   Position the lasso so that the bottom of the "knot" on the cursor is close to the atom you 
want to move. The lasso will change and display an "A" inside it. 

2.   Click and the lasso changes to a hand, and the node is enclosed by a box (if the hand 
does not appear move the lasso into the box). 

3.   Click, hold, and drag the atom to a new position. 

 
Text Tool 

Use the Text Tool to add on-screen text and labels. Text is not searchable. 

Text font can be changed via the Colors/Fonts tab of Preferences. The change is global and the 
setting for the text will be applied to all the text in the Structure Drawing window. 

 

57 



Structure Drawing Tools 

Shortcuts 

Click right to change the color and font. 

 
Reaction Arrow 

Use the Reaction Arrow tool to draw a variety of reaction arrows. Click on the button alongside 
the arrow that you want to use followed by OK. 

Arrows are drawn, from the tail to the arrowhead, by clicking, holding, and dragging the cursor. 
Reaction roles are automatically assigned to fragments when an arrow has been drawn. If 
reaction roles are not assigned, erase and redraw the arrow in closer proximity to the fragments. 

Shortcuts 

Click right on the Reaction Arrow to select the default arrow. 

Note: Reaction tools are disabled for normal drawing modes. Select the Rxn Tool from the 
toolbar or choose Show Reactions from the Display Menu. 

 
Reaction Role Tool 

The Reaction Role tool can be used to modify reaction roles that are automatically assigned 
when in reaction drawing mode. Point to a atom in the fragment whose role you want to change, 
using the arrow cursor and click. Select the role you want to use from the Role Specification 
Selection dialog. 

Note: Reaction tools are disabled for normal drawing modes. Select the Rxn Tool from the 
toolbar or choose Show Reactions from the Display Menu. 

 
Reaction Site Tool 

Reaction Sites can be specified on bonds. Using the star cursor, point to each bond in turn that 
you want to assign a reaction site label to and click. The options are: 

CC - this bond is completely changed that is either formed or broken. 

PC - this bond is partially changed, that is the bond value changes, e.g., an exact bond becomes 
normalized. 

XC - the bond may be either completely or partially changed. 

NC - the bond is unchanged. 

NON - no reaction site specification is declared. 

Note: Reaction tools are disabled for normal drawing modes. Select the Rxn Tool from the 
toolbar or choose Show Reactions from the Display Menu. 
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Atom Mapping Tool 

The Atom Mapping tool is used to specify a correspondence between atoms in the reactant and 
atoms in the product. 

To use this tool: 

1.  Click the Atom Mapping tool from the Tool Palette. 

2.   In the dialog box, select either the Manual Mapping or the Automatic Mapping option to 
get a message telling you how to use the selected option.  

Manual Mapping - Using the cross cursor, point to an atom in the reactant and click and then 
point to the corresponding atom in the product. The atoms will be assigned a mapping number 1. 
Repeat for subsequent pairs of reactant and product atoms. 

Automatic Mapping - This option causes the fragments to be automatically mapped where 
possible. 

To delete mappings, use the Eraser Tool or the Delete Mappings command from the Edit 
Menu. 

 Reactant atoms can only be mapped onto product atoms (and vice-versa), and two different 
atoms cannot be mapped. 

 
Functional Group Tool  

This tool allows functional groups to be used to build a reaction search query.   

A New window must be started when enabling the FG tool on the Toolbar. Functional Group 
queries cannot contain any other drawn structural fragments. 

Note: Functional Group tools are disabled for normal drawing modes. Select the FG Tool from the 
toolbar. Reaction tools will also be enabled and disabled accordingly. 

Shortcuts 

Click right on a Functional Group in the drawing area to obtain detailed information about the 
CAS definition of the group.  

 
OR Tool for Functional Groups 

This tool allows functional groups to be linked with an OR operator for searching. Brackets are 
drawn from upper left to lower right by clicking, holding, and dragging the cursor. 

Note: Functional Group tools are disabled for normal drawing modes. Select the FG Tool from the 
toolbar. Reaction tools will also be enabled and disabled accordingly. 
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Horizontal Tool Palette 

Horizontal Tool Palette Content 

The Horizontal Tool Palette of the Structure Drawing window contains: 

• The Current Atom Box 
• The Common Atoms Box 
• The Current Bond Box 
• The Common Bonds Box  

 
Current Atom Box 

The Current Atom Box in the Horizontal Tool Palette of the Structure Drawing window displays 
the current atom.  

The default atom is C. Click left on the Current Atom Box to select a different atom, shortcut, or 
variable via the Atom Selection preference setting defined in Preferences/Drawing. Click right on 
the Current Atom Box to get the List box selection method. 

A click in this box resets the drawing tool to the Pencil tool. 

 
Common Atoms Palette 

The Common Atoms Palette in the Horizontal Tool Palette of the Structure Drawing window 
displays some common atoms.  

A single click on the symbol of an atom will select it for single use. A double click will select the 
atom for multiple use. 

Atoms, shortcuts, and variables can be selected by clicking on the Current Atom Box . See the 
Drawing tab of Structure Preferences to set the Atom Selection style. Atoms, Shortcuts and 
Variables can also be selected from the appropriate dialogs in the Draw menu. 

The default atom is Carbon for using the Pencil Tool for drawing structures.  

Click the Reset Atom/Bond button to return to the atom and bond defaults: C for carbon atom 
and a single bond.  

 
Current Bond  

The Current Bond Box displays the current bond. The default bond is single. A different bond can 
be selected by clicking on the Current Bond Box. Click on the button next to the bond you want to 
use followed by Single Use or Multiple Use. This bond now becomes the current bond. 

A click in this box resets the drawing tool to the Pencil tool. 
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Common Bonds 

The Common Bonds palette in the Horizontal Tool Palette of the Structure Drawing window 
displays some common bonds.  

A single click on a bond will select it for single use. A double click will select the bond for multiple 
use.  

Other different Bond types can be selected by clicking on the Current Bond Box or by selecting 
Bond from the Draw menu. 

To join two atoms by a single bond, use the Pencil Tool and click on an existing atom and then 
hold, drag, and release the mouse button 

Modify an existing bond by selecting the bond that you want to use from the bond selection dialog 
and then point to the existing bond and click. Notice that the Pencil Cursor changes to display a "-
-" when pointing to an existing bond. You can modify several bonds by selecting the bond(s) you 
want to change (using the Selection Tool) before picking the new bond type. 

Bonds of fixed length can be drawn by checking Snap Bonds in the Drawing tab of Structure 
Preferences and setting a value for Bond Length (e.g., 10 mm). Bonds are then automatically 
drawn to the nearest compass position so that "almost horizontal" bonds are drawn horizontally. 
This makes it easier to produce regular diagrams. Fixed bond length can be overridden by 
holding the shift key down when drawing a bond. It is also overridden when a bond is drawn 
between two existing atoms. 

Click right on a common bond position to change the value to your own preference. 

A click in this box resets the drawing tool to the Pencil tool. 

Click the Reset Atom/Bond button to return to the atom and bond defaults: C for carbon atom 
and a single bond.  
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Standard Toolbar in Structure Drawing 

The standard toolbar displays at the top of the Structure Drawing window.  The standard toolbar 
provides quick and easy access to common functions.   

Toolbar Button Function 

 
Open a new Standard STN structure drawing window 

 
Open existing structure drawing queries 

 
Save the current structure 

 
Print the current structure 

 
Undo the last action 

 
Cut the selected structure or structure fragment and places it on the 
clipboard 

 
Copy the selected structure or structure fragment and place it on the 
clipboard 

 
Paste the clipboard contents into the current structure query 

 
Display the Shortcut menu which contains shortcuts to insert in your 
query 

 
Display the Variable Selection menu, which contains variables to insert 
in your query 

 
Verify the query's attributes 

 
Fuse two structures or structure fragments together 

 
Center the structure in the Structure Drawing window 

 
Display the carbon atoms as C, dots, or angles 

 
Toggle the use of the reaction drawing mode 

 
Toggle the use of the Functional Group drawing mode 

 
Set structure drawing preferences 

 
Logon to an online vendor 

 
Show STN Express help topics 
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Additional toolbar buttons  

button Function 

 
Open a new SpecInfo structure drawing 
window 

 
Open a new WPI structure drawing window 

 
Save the current structure with a new name 

 
Analyze the structure query and suggest 
filters 

 
View existing filters 

 
View the existing Functional Group 
command file 
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Structure Drawing Menus 

Structure Drawing Menu Bar Content 

The Structure Drawing menu bar displays at the top of the Structure Drawing window. 

The menu bar contains the following menus: 

• File menu 
• Edit menu 
• Draw menu 
• Template menu 
• QueryDef menu 
• Display menu 
• Structure Preferences menu 
• Window menu 
• Help menu 

 
 
File Menu for Structure Drawing 

Menu Item Function 
New Opens a new Structure Drawing window  
Open Opens an existing structure query 
Close Closes the current Structure Drawing 

window 
Browse Browses through the saved structures 
Save Saves and name the current structure 
Save As Allows you to save a structure in an 

alternate format or with a different file name 
Page Setup Allows you to set the page for printing the 

structure 
Print Preferences Allows you to set options for printing the 

query, such as including query attributes or 
enclosing the query in a box 

Print Prints the current structure 
Exit Exits the structure drawing application  
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Edit Menu for Structure Drawing 

Menu Item Function 
Undo  Erases the last function and restores the 

item to its previous condition 
Cut Removes a selected structure or fragment 

and places it on the clipboard 
Copy Copies a selected structure or fragment to 

the clipboard 
Paste Places the contents of the clipboard at the 

location of your cursor 
Select All Selects everything in the Structure Drawing 

window 
Clear Removes a selected structure or fragment 
Clear All Clears everything from the Structure 

Drawing window 
Copy SMILES Copies the selected object to the clipboard 

in SMILES format 
Show Clipboard Displays the contents of the clipboard 
Repaint Forces the screen to re-paint  
Delete Mappings Delete mappings applied with the Atom 

Mapping tool 
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Draw Menu 

Draw Menu for Structure Drawing 

Menu Item Function 
Bond Allows you to change the current bond 
Atom Allows you to change the current atom 
Shortcut Allows you to change the current atom to a 

shortcut, i.e., a predefined group of atoms 
Variables Allows you to change the current atom to a 

variable, i.e., a generic atom such as M for 
metals 

Variable Points of Attachment Allows you to indicate variable points of 
attachment of a structure fragment to a core 
ring structure 

G-groups Defines and inserts generic groups 
Repeating Groups Defines and inserts repeating groups 
Delete Repeating Group Removes a repeating group  
Chain Superatoms Inserts a chain superatom into a WPI 

structure 
Ring Superatoms Inserts a ring superatom into a WPI 

structure 
Other Superatoms Inserts a superatom other than a chain or a 

ring superatom into a WPI structure 
Square Brackets Inserts brackets around a structure or a 

structure fragment for referencing in another 
application 

Fuse Fragment Joins two fragments  

 
 
Variable Points of Attachment in Structure Drawing 

A Variable Point of Attachment (VPA) lets you draw a query with a substituent on a ring where the 
attachment point on the ring is one variable. For example, if you are interested in pyridine with 
chlorine attached at the 1, 2, or 3 positions, draw a VPA. 
 
Select two or more (maximum 20) nodes in a single ring system, along with a node in a 
substituent fragment. Then click Draw > Variable Points of Attachment. A bond is drawn from 
the fragment to the center of the ring system. To see the specific attachment points on the ring, 
click Display > Show VPA. 
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Using Repeating Groups 

You can insert a repeating group into your structure query.   

To create and use a repeating group: 

1.   Draw a structure that will contain the repeating group. 

2.   With the Selection tool, select the nodes that are to become members of a repeating 
group. Hold the Shift key to select more than one node. There must be two attachments 
to the repeating group that are not part of the repeating group. 

3.   Select Repeating Groups from the Draw menu.  In the Repeating Group Range dialog 
box, type the numerical range for the group to repeat (0-20 times).  Click OK.  

The group is bracketed and subscripted with the repeating range entered.   

To delete a repeating group from a structure: 

1.   Click the Selection tool.  Select an atom in the repeating group to be deleted. 

2.   Select Delete from the Draw menu to delete the repeating group definition.   

The atoms in the repeating groups are not deleted.  Only the brackets and repeating range are 
deleted. 

 
 
Fuse Fragment in Structure Drawing 

Use the Fuse Fragment option to fuse two fragments together either at a node or at a bond. 

To use Fuse Fragment:  

1.   With the Selection Tool pre-select either a node or a bond in one fragment. The Fuse 
Fragment option in Draw menu becomes active.  

2.   Select Fuse Fragment from Draw menu and the cursor will change to two facing arrows.  

3.   Place the cursor over a suitable object for fusing. If a node in fragment 1 is selected, then 
the cursor needs to be over a node in fragment 2 to be valid for fusion. Similarly if a bond 
is selected in fragment 1, then the cursor becomes active only when it is positioned over 
a bond in fragment 2. The second fragment selected is fused onto the first. That means 
that the orientation of the first fragment selected is preserved, the second fragment 
selected may be rotated to allow fusion. Also, the atom and bond types in the first 
fragment are preserved; they override those in the second fragment selected.  

Use the Undo Fuse command in the Edit menu to undo the fuse if you do not like the results. 
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Using G-Groups 

Using G-Groups Overview  

G-groups are a type of variable fragment that you can define. A single G-group may have 
between 1 and 20 definitions that can be atoms, shortcuts, variables, structure fragments, or 
other G-groups. Up to 20 G-groups may be defined.  G-groups are numbered consecutively, i.e., 
G1, G2, G3 etc.  

This topic includes: 

• Using G-groups with atoms, shortcuts, or variables 
• Using G-groups with structure fragments  

 

Using G-Groups with Atoms, Shortcuts, or Variables 

1.   Draw a structure.  

2.   Select G-groups from the Draw menu to display a G-Group Definitions dialog box.  

3.   Click New. The Define New G-Group dialog box is displayed.  

4.   Click Atoms, Shortcuts, or Variables. An appropriate dialog box, e.g., Atom Selection is 
displayed. Make selections for the definition of your G-Group.  Click OK when you are done.  

5.   Click Save in the Define New G-Group dialog box.  

6.   Select Single Use or Multiple Use in the G-Group Definitions dialog box.  

7.   In the Structure Drawing window position the G-group at the desired location.  

 

Using G-Groups with Structure Fragments  

You may use a G-Group defined by one or more structure fragments. You may have multiple (1-
20) points of attachment for each G-group. 

1.   Draw your core structure and the structure fragment(s) that you wish to include in the G-
Group definition. 

2.   On each fragment, identify points of attachment to the core structure.   

- Select G-groups from the Draw menu. 

- In the G-Group Definitions box, highlight @ point of attachment and click Single Use 
or Multiple Use.  
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- Click on each node of the structure fragment(s) where you want the fragment attached 
to the core structure.  The points of attachment are marked   with "@." 

3.   Define a G-Group with your structure fragment(s).   

- Select G-Groups from the Draw menu. 

- Click New in G-Group Definitions box. 

- Click Fragments In the Define New G-Group dialog box.  

- In the G-Group Fragments dialog box you have the following options: 

• If only one fragment is present in the structure, this fragment will be highlighted. 
Click Include This Fragment to select the fragment.   Click OK.  Continue to 
define the G-Group in the Define New G-Group box by selecting Atoms, 
Shortcuts, or Variables.  

• If multiple fragments are present in the structure and they all belong to a single 
G-Group, click Include All Fragments.  Click OK. Then you may add any other 
Atoms, Shortcuts, or Variables to further define the G-Group in the Define New 
G-Group box. 

• If multiple fragments are present in the structure and they belong to different G-
Groups, select and include one fragment at a time.  To select the highlighted 
fragment in the G-Group definition, click Include This Fragment. To highlight 
another fragment, click Next Fragment/Previous Fragment. Click Include This 
Fragment when all the fragments are selected.  Click OK.  

4.   Click Save in the Define New G-Group box to save the G-Group containing the structure 
fragment(s).  

5.   Place the G-Group containing the structure fragment(s) onto the core structure.  

 
 
Template Menu in Structure Drawing 

The Template menu contains a collection of predefined structures you can use.  You may also 
draw your own structure and save it as a template.  

To insert a template into your Structure Drawing window:  

1.  Select Template form the Structure Drawing Menu bar. 

2.   In the Open Template dialog box, select a template file name in the File name box.  The 
structure is shown.  Click Open.  

3.   The structure for the template you selected is displayed in the Template dialog box.  Select 
the entire structure or a structure fragment and click OK.  

4.   The Template dialog box disappears.  In the Structure Drawing window, click to insert the 
selected structure.  
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QueryDef Menu 

QueryDef (Query Definition) Menu for Structure Drawing 

The QueryDef menu is used to define attributes of your structure.   

To define an attribute: 

1.   Click the Selection or Lasso tool. 

2.   Select one or more nodes in the fragment for which an attribute is defined. 

3.   Select the option from the QueryDef menu.   

4.   Select the attributes from the dialog box.  Click OK.  

To set attributes for a single atom or bond, right-click on that object and select the desired 
attribute from the pull-down menu. 

You can define the following attributes: 

• Ring Isolation 
• Bond Characteristics 
• Node Characteristics 
• Hydrogen Attachments 
• Non-hydrogen Attachments 
• Other Attributes 
• Generic Definition 
• Markush Attributes  
• Element Count 
• Delocalized Charge 
• Stereochemistry 
• Free Sites 
• Review Functional Group STN Commands 
• Query Verification 

 

Ring Isolation 

You can use the Ring Isolation on the QueryDef menu to define ring isolation as: 

• Isolated/Embedded: search for structures with the selected ring system either isolated 
or embedded in a ring system 

• Isolated: search for structures that have no additional ring fusion to the selected ring 
system.  Additional substitution is allowed at nodes in the ring 

• Mixture: This is selected when multiple rings are selected with different ring isolation 
settings.  Changing the ring isolation value changes all selected rings, regardless of 
previous settings.  
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Bond Characteristics  

Bond Characteristics on the QueryDef menu is used to define the following bond characteristics.   

Bond types 

• Chain:  search results include only structures containing chain bonds at the specified 
location. 

• Ring/Chain: search results include structures containing bonds in either rings or chains 
at the specified location.  When you change a chain bond to a ring/chain bond, the atoms 
on either side of the bond are also set to ring/chain.  

• Ring:  search results have a ring containing the bond at the specified location.  This is 
the default type for ring bonds.  When you change a chain bond to a ring bond, the atoms 
on either side of the bond are also set to ring.  You cannot alter the bond type in a drawn 
ring. 

Bond values  

• Exact/Normalized: search results match answers with either the exact bond value drawn 
or with normalized bonds  

• Exact: search results exactly match the bond value that is drawn. 
• Normalized:  search results match only normalized bonds.  This is the default for even 

membered rings with alternating single and double bonds and for  tautomeric bonds. 
• Unspecified: search results will match with any bond value. 
• Mixture: the bond value when more than one bond is selected with different bond values. 

It is selected in the dialog but is still grayed, as it is not a user-selectable choice. 
Changing the bond value changes all selected bonds, regardless of previous settings. 

 

Node Characteristics  

Node Characteristics on the QueryDef menu is used to specify node characteristics on your 
structure. 

• Chain: Search results include only structures containing chain nodes at the specified 
location. This is the default for drawn nodes in a chain. Chain nodes can be changed to 
ring or ring/chain nodes. Changing node characteristics at either end of a bond does not 
change the bond value. 

• Ring: Search results include only structures containing ring nodes at the specified 
location. This is the default for nodes in rings and cannot be changed. 

• Ring/Chain: Search results include structures containing chain nodes or ring nodes at 
the specified location. 

• Mixture: The node characteristic when more than one node is selected with different 
node characteristics. It is selected in the dialog but is still grayed as it is not a user-
selectable choice. Changing the node value changes all selected nodes, regardless of 
previous settings. 
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Hydrogen Attachments 

Hydrogen Attachments on the QueryDef menu is used to specify either an exact or minimum 
number of H attachments on a node. 

Note: This value should not contradict (and therefore must include) any H's drawn in the structure 
query. 

 

Non-Hydrogen Attachments 

Non-Hydrogen Attachments on the QueryDef menu is used to specify non-Hydrogen attachments 
on your structure.  

You may specify an exact, minimum, or maximum number of attachments on a node other than 
hydrogen and the nature of those attachments. 

Note: This value should not contradict (and therefore must include) the number and type of 
connections drawn in the structure query. 

 

Other Attributes 

Other Attributes on the QueryDef menu is used to specify the following attributes: 

• Charge: default is ANY, which retrieves both charged and uncharged substances. 
• Valency: default is ANY. Valency is equal to the total number of bonds to a node, plus 

the absolute value of the charge. 
• Isotope: default is ANY, which retrieves any isotope value, including none. 

This option is not active if more than one node is selected. 
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Generic Definition 

Generic Definition on the QueryDef menu is used to specify attributes of generic nodes.  Select 
generic nodes (Ak, Cb, Cy, or Hy) of the same type to enable this option. 

The following options are available:  

Attribute Options 
Saturation • Saturated - all bonds are single exact 

• Unsaturated - at least one double exact, triple, or normalized 
bond. 

Type of Chain • Linear - all atoms have one or two attachments 
• Branched - at least one atom has more than two 

attachments 
Number of 
Hetero Atoms 

Specify number of non-carbon atoms 

Type of Ring 
System 

• Monocyclic - one bond must be broken to change the system 
into a chain; 

• Polycyclic - two or more bonds must be broken to change the 
system to a chain. 

Number of 
Carbon Atoms 

Default is ANY, can be set to >7 or <7. 

 

Markush Attributes 

Markush Attributes on the QueryDef menu is used to specify the following attributes that affect 
searching in MARPAT®: 

• Match Level: 

Class: matches at either class or atom level; the initial default for chain nodes. 

Atom: limits the search to structures matching at the atom level; the initial default for 
ring nodes. 

Any: matches at any level, including generic R-groups. 

• Element Count Level: 

Can be set to Limited or Unlimited for a selected node. 
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Element Count 

Element Count on the QueryDef menu is used to limit the types and numbers of elements in 
generic groups or to limit the types of Markush retrievals for your query.   

To use Element Count: 

1. Select one or more generic nodes in your structure. 
2. Select Element Count from the QueryDef menu.  
3. In the Element Count dialog box choose the elements that you wish to limit in your query. 

Select Exact, Range, Minimum, or Maximum.  Click Add to apply the Element Count to 
selected nodes.  The elements available for selection depend upon the generic group 
selected. Click Remove to remove the Element Count from selected nodes.  Click OK to 
return to structure building.  

4. Check the Limited box to match generic groups that explicitly meet your Element Count 
specification.  If the Limited box is not checked, generic groups that merely imply your 
Element Count specification will be matched. 
   

Delocalized Charge 

Delocalized Charge in the QueryDef menu is used to change the default setting for selected 
nodes.  

To use Delocalized Charge:  

1. Select adjacent nodes.   
2. Select Delocalized Charge from the QueryDef menu.   
3. In the Delocalized Charge dialog box select a delocalized charge from the scrollable list. 

Any: retrieves substances with or without a delocalized charge. This is the default. You 
may also select a specific number between 5+ and 5- or Any+ and Any-. 

4. Click OK.   

 
Stereochemistry 

You can use Stereochemisty on the QueryDef menu to specify stereochemical attributes of a 
structure. 

Stereochemical searches can be Relative or Absolute. Relative is the default, it allows retrieval 
of both possible enantiomers. An Absolute search only retrieves the enantiomer drawn in the 
query. 

To search for structures with double bond geometry, select the double bonds and then choose 
the Stereo option under Geometric Bonds. 

Stereo Set options are used to define different stereo groups within a single structure. Select the 
desired nodes and then choose the appropriate options under Stereo Set. 

Node Attribute options are used to alter stereo structures, e.g., flatten, invert. 
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Note: If an invalid pattern of stereo bonds has been drawn, an error message is displayed in the 
Stereochemistry dialog. Use Query Verification for more information on drawing stereo 
centers. 

 

Stereo Display Label 

A stereo label for display only can be added to any node that has one or more stereo bonds. 
Select the node and then the stereo command that will be enabled. Click on Specific, followed by 
the label that you want to use. Stereo labels can be deleted using the Eraser Tool, or moved 
using the Lasso Tool 

 

Free Sites 

You can use Free Site on the QueryDef menu to specify Free Sites when creating WPI 
structures. 

This option allows you to change the default setting for the selected nodes. The default setting, 
None, retrieves search results containing the normal valency of the atom with hydrogen 
attachments only. You may also specify a maximum, between 1 and 9, for non-hydrogen 
attachments. 

 

Review Functional Group STN Commands 

You can use Review Functional Group STN Commands on the QueryDef menu to display the 
STN command file that is created when a Functional Group query is saved. Unsaved changes to 
the FG query will not be reflected in the command file. 

 
Structure Query Verification 

Query Verification on the QueryDef menu is used to verify your structure query.   

Select All to review all the current structure’s attributes. Choose Select to deselect options. Then 
check the options you wish to review for: 

• Bonds 
• Rings 
• Stereo 
• Nodes 
• G-groups 

The attributes selected from the Query Verification dialog are displayed in turn with the attribute 
highlighted. Click OK to continue and display the next attribute. Click Cancel to leave Query 
Verification. 
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Display Menu in Structure Drawing 

The Display menu options affect only the appearance or orientation of your current structure, not 
search results. 

Menu option What it does 
Carbons Changes the display of some carbon atoms in the current structure. 

Select any carbons that you wish to display differently and Click this item. 
A secondary pop-up appears allowing you to choose between Dots, 
Angle, or C symbols for any selected carbon atoms. Note that the 
display of all carbons can be changed using the Carbons option under 
Drawing Preferences. 

Stereo Adds a stereo label for display to any node that has one or more stereo 
bonds. Select the node and then Stereo. Click on Specific, followed by 
the label that you want to use. Stereo labels can be deleted using the 
Eraser Tool, or moved using the Lasso Tool. 

Show VPA Displays the potential connection sites of a variable positioned group on a 
ring system.  

Show Node 
Numbers 

Replaces all nodes with a node number. Node numbers are assigned in 
the order nodes are placed on the screen.  Select Show Node Symbols 
a second time to turn this display off. 

Ring Circles Displays alternating single and double bonds in six membered rings as a 
circle inside the ring. 

Show 
Reactions 

Displays Reaction information: Reaction Roles, Reaction Sites, Reaction 
Mapping, and Atom Mapping. 

Show Query 
Attributes 

Displays activated viewer for the Query Attributes, which displays the 
attributes for a node or bond at the current cursor position. The display 
changes as the cursor is moved over different nodes or bonds. 

Smooth Allows you to improve the appearance of rings or chains drawn freehand. 
If you do not like the appearance of the smoothed structure use the Undo 
command. 

Expand Enlarges and centers the drawing on the screen. If the structure expands 
out of the current viewing port, use the scroll bars to view it. One or more 
discrete fragments can be selectively expanded. Use the Selection tool 
to select the fragment(s) before using the Expand option. 

Contract Reduces the size of the drawing on your screen and centers it. One or 
more discrete fragments can be selectively contracted. Use the Selection 
tool to select the fragment(s) before using the Contract option. 

Reverse 
Shortcut 

Displays a shortcut in its reverse form. For example, an "OH" group with a 
horizontal bond extending to the right is usually drawn as "HO". Select the 
shortcut to be reversed then select Reverse Shortcut from the Display 
menu. Where possible, the bond is drawn to the relevant node in the 
shortcut. 

Rotate Rotates a structure about an atom or bond on the screen. Select the 
structure or fragment that you want to rotate. Then choose Rotate 
command.  The cursor changes displaying a curved arrow around a dot 
which shows the direction of rotation. Click and move the cursor in a 
clockwise or counter clockwise direction. The fragment will be rotated in 
that direction about a central axis. 
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Menu option What it does 
Flip Fragment 
Horizontal 

Makes a left-right rotation of a structural fragment through 180 degrees. 
The structure is rotated about a vertical axis creating a mirror image. 

Flip Fragment 
Vertical 

Makes an up-down rotation of a structural fragment through 180 degrees. 
The structure is rotated about a horizontal axis creating a mirror image. 

Show Grid Show a grid in the structure drawing window. 
Snap to Grid Select a set of nodes or a fragment, then use this command to snap the 

nodes to the nearest grid position. 
Snap to 
Compass 

Select a set of bonds or a fragment and use this command to snap the 
bonds to the nearest compass position. 

 
 
Window Menu in Structure Drawing 

Several query structures can be open at the same time. Each open file is displayed in a separate 
window; the open windows can be tiled, cascaded or displayed as icons.  All open windows are 
listed in the Window Menu. The current window is checked.  The Window Menu provides options 
for the appearance of structure windows.  

Menu option How it works 
Cascade Causes all open windows to be cascaded, 

with the current window on top. Clicking on 
any window in the cascade makes it the 
active window and brings it to the top of the 
cascade. 

Tile Horizontal Causes all open windows to be tiled 
horizontally so that several queries can be 
displayed and modified simultaneously, e.g., 
fragments can be copied and pasted 
between windows.  

Tile Vertical Causes all open windows to be tiled 
horizontally or vertically 

Arrange Icons This option becomes active when an open 
window has been minimized. Each open 
window can be minimized (displayed as an 
icon) by clicking on the down arrow on the 
header bar of that window. The down arrow 
is displayed only when windows have been 
cascaded or tiled. Arrange Icons displays all 
open window icons at the bottom left of the 
drawing screen. Click, hold and drag on an 
icon to move it. Click once on an icon and 
then on the Restore option to redisplay the 
window in either the tiled or cascaded form. 
The Maximize option maximizes that 
window so that it fills the structure drawing 
screen. 

Close All Closes all open drawing windows.  



Reaction Queries 

Reaction Queries 

Drawing a Reaction Query 

To draw a reaction query: 

1. Open the Structure Drawing window by clicking on the Prepare Query button on the 
Main Menu Toolbar or selecting Prepare Structure Query from the Query menu. 

2. Click the Reaction (Rxn) button on the Structure Drawing Toolbar or select Show 
Reactions from the Display menu.  The Structure Drawing window is displayed in 
Reaction mode, and the Reaction Drawing tools are activated on the Tool Palette:  

• Reaction Arrow tool  - to set up a chemical reaction between structures 
• Reaction Role tool  - to specify the roles of the participants in a reaction 
• Reaction Site Tool - to specify a reaction site label for a specific bond 
• Atom Mapping Tool - to specify a correspondence between atoms in the reactant and 

atoms in the product 

 
 
Using Functional Groups in a Reaction Query 

To use Functional Groups in a Reaction Query: 

1. Open a new window by selecting New/Standard from the Structure Drawing File menu or 
clicking the New/Standard button located on the Toolbar. 

2. Click the Functional Group button on the Toolbar in the new Structure Drawing window. 
The following reaction drawing tools and the functional group drawing tools on the bottom 
of the Tool Palette are activated: 

• Reaction Arrow 
• Reaction Role 
• Reaction Site 
• Atom Mapping 
• OR tool for Functional Groups 
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WPI Structures 

Creating WPI structures 

To create a structure for searching in the WPI databases: 

1. Create a structure in the Structure Drawing window and save it as a standard structure. 
The .str extension is automatically applied, e.g., pyraz.str. 

2. Open the standard structure in the Structure Drawing window. In the Open Query dialog 
box click WPI under Convert to and click Open. The structure is displayed in the 
Structure Drawing window and is identified as a WPI structure, e.g., pyraz.str *WPI.*    

3. To insert superatoms into a WPI structure, select Ring Superatoms, Chain 
Superatoms, or Other Superatoms from the Draw menu and make your selections. 

To include non-structural codes and sugar codes for your WPI Fragmentation code strategy: 

1. Select Include WPI Other Code Concepts from the Query menu. 
2. Select the codes you want by clicking Select Codes, then on the appropriate 

descriptor(s) from the menus.  Selected codes appear in the lower window, with the 
definitions in the upper window.  To combine codes using Boolean AND or OR, click on 
the menu heading to toggle between them.  Use Delete Last or Delete All to erase your 
selection. 

3. Select Leave OCC or minimize the OCC window to return to the main STN Express 
menu.  If you have not yet drawn your structure, you can do it now; the selected non-
structural codes will remain active.  When you have drawn and saved your structure, 
leave structure drawing and return to the main STN Express menus.   

To generate WPI fragmentation code strategy from your structure, select Generate WPI Strategy 
from the Query main menu. 

 
 
Ring Superatoms for WPI Queries 

To use Ring Superatoms: 

1. Select Ring Superatoms from the Draw menu in order to insert a ring superatom into a 
WPI structure query only.  

2. In the Ring Superatoms dialog box, click the button next to one of the ring superatoms.   
3. Click Single Use or Multiple Use. 
4. Insert the ring superatom at the desired location in your structure.   

Options for Ring Superatoms are: 

•  CYC: Cycloaliphatic - Carbocyclic, optionally fused 
•  ARY: Aryl-Carbocyclic, optionally fused, containing at least 1 benzene ring 
•  HEA: Heterocyclic - Aromatic, Monocyclic (5 or 6 ring atoms) 
•  HET: Heterocyclic - Non-aromatic, Monocyclic 
•  HEF: Heterocyclic - Fused, optionally aromatic 
•  HEO: Heterocyclic - containing metal, halogen, or B, Si, P, or As 
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Other Superatoms for WPI Queries 

To use Other Superatoms: 

1. Select Other Superatoms to insert a superatom other than a chain or a ring superatom 
into a WPI structure query. 

2. Click the radio button next to one of the "other" superatoms in the Other Superatoms 
dialog box. 

3. Click Single Use or Multiple Use. 

Options for Other Superatoms are: 

•  AMX: Alkali (ne Earth) Metal 
•  A35: Group IIIVa Metal - Al, Ga, In, Tl, Ge, Sn, Pb, Sb, Bi 
•  TRM: Transition Metals excluding Lanthanum 
•  LAN: Lanthanide (including Lanthanum) 
•  ACT: Actinide (including Actinium) 
•  MX: Metal, any 
•  HAL: Halogen 
•  TX: O, S, Se, Te 
•  UX: O, S, Se, Te, N 
•  ZX: B, Si, P, As 
•  TM1: First series transition metals 
•  TM2: Second series transition metals 
•  TM3: Third series transition metals 

 

Other Code Concepts for WPI Queries 

The Other Code Concepts in the STN Express Query menu is used to include non-structural 
codes and sugar codes in your Fragmentation code strategy. These codes can be selected 
before or after drawing your structure, by choosing the Include WPI Other Code Concepts from 
the STN Express Query menu. 

To use Other Code Concepts:  

1. Select the codes you want by clicking Select Codes.   On the appropriate descriptor(s) 
from the menus selected codes appear in the lower window, with the definitions in the 
upper window.   

2. Codes can be combined using Boolean AND or OR.   Click on the menu heading to 
toggle between them.  Use Delete Last or Delete All to erase your selection. It is not 
possible to select truncated codes directly, but you can include them by selecting a 
specific code, generating the strategy, and then editing the strategy. 

3. When you have finished selecting codes, select Leave OCC or minimize the OCC 
window.  This returns you to the main STN Express menu.  (If you have not yet drawn 
your structure, do so now - the selected non-structural codes will remain active.  When 
you have drawn and saved your structure, leave structure drawing and return to the main 
STN Express menus.)   

4. Select Generate WPI Codes from the Query menu, and select the name of the saved 
structure. Click in the checkbox labeled Include, to mark it with an x, and click on 
Generate. The selected non-structural codes will be included in your strategy. 
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Generating WPI Fragmentation Code Strategy 

You can generate a WPI fragmentation code strategy from a structure for searching in the WPIDS 
or WPINDEX databases on STN as follows: 

1. Create a WPI structure. You may also choose to include non-structural codes and sugar 
codes for your WPI Fragmentation code strategy.  You may add these codes before or 
after drawing your structure by selecting Include WPI Other Code Concepts from the 
Query menu. 

2. Select Generate WPI Strategy from the Query main menu.  
3. Open a WPI structure.  The structure is displayed in the preview box.   
4. Select the SUBS you want to search.  
5. Select Include OCC if you had included Other Code Concepts in your strategy.  This 

option is not available if codes have not been pre-selected.  
6. Check Generate RIN codes only to generate only RINs for your WPI structure. 
7. After the WPI Fragmentation code strategy has been generated, STN Express displays 

the strategy in the File Editor window.  The strategy is in the form of an STN Express 
command file with the .sc extension applied to the name of the structure.   The definition 
of any code can be displayed on the screen, to help with checking and editing of the 
strategy.  Position the cursor anywhere within the code, and choose the Code definition 
command from the Utilities menu.  

8. Save the strategy using the Save or Save As command from the File menu.  In addition 
to the actual command file, the program also creates a file with the extension .stg which 
contains information about any linked structure.  

9. To run the WPI Fragmentation Code Strategy, enter the file, e.g., WPIDS, select Run 
Command File from the Query menu and open the .sc file with your fragmentation 
strategy. 
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Structure Preferences Menu 

Structure Preferences Menu Content 

Menu Item Function 
Chemistry Allows various chemical preferences to be 

set, for example, Markush match level 
defaults, or the Me/CH3 display of Methyl 
option. 

Layout Changes the Structure Drawing desktop 
layout 

Save Time Allows preferences to be set for saving 
structure queries. 

Warnings Allows the display of warning messages to 
be switched off. Select the warning that you 
do not want displayed, followed by Disable 
to switch off the display of that message. 

Colors/Fonts  Changes the colors and fonts of atom 
symbols, bonds, selections, etc. 

Drawing Sets the default drawing preferences. There 
are various options that can be selected to 
change the display of the structure diagram. 

 

Structure Preferences: Chemistry 

Option What it does... 
Show VPA Shows the variable substituent's 

connections to its ring nodes in a Variable 
Point of Attachment (VPA) as dotted bonds. 
These can subsequently be hidden by 
deselecting Show VPA. 

Limited Sets the default for Markush attributes. This 
may be changed for any given atom with the 
Markush Attributes or the Element 
selection from the QueryDef menu. 

Use Bond Algorithm This default is used when drawing queries 
for searching. All bonds are set to 
exact/normalized if this option is unchecked; 
otherwise, the bond algorithms are applied.  

Show Reactions When this option is checked, reaction 
information is displayed, and reaction 
drawing tools on the drawing palette are 
activated. This option is available via the 
RXN button on the toolbar. 

Markush Match Level Defaults  Markush Attributes affect search results 
only in the MARPAT File. The defaults for 
Ring Nodes or Chain Nodes can be 
changed.  

Methyl Display Display CH3 or Me. 
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Structure Preferences: Layout 

Content How the Layout changes 
Palette The Palette display is optional and when 

displayed can be displayed horizontally or 
vertically and as a single or double line. The 
display format can be changed through the 
Layout option, or by clicking left on the open 
gap at the bottom of the palette to make 
changes from the Structure Drawing 
Window. 

Toolbar The Toolbar display is optional and when 
displayed can be displayed horizontally or 
vertically and as a single or double line. 
Additional tools can be added to the toolbar 
or tools can be repositioned to meet your 
preference. Existing tools can also be 
removed from the toolbar by replacing with 
a toolbar gap or closing a toolbar gap. Click 
right on the toolbar at the position you wish 
to modify and select the appropriate button 
from the list. 

Status Bar The Status Bar, if displayed, can show 
Menu Help on the left and the Molecular 
Formula and the Clock on the right.  

Tool Tips Tool Tips are displayed if this box is 
checked.   
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Structure Preferences: Save Time 

Option What the effect is 
Autosave Automatically saves any query being drawn 

after the number of seconds specified. For 
Untitled queries, you will be prompted for a 
name, followed by the standard Save 
options. If you choose to cancel this option, 
you will be prompted again (after the 
specified number of seconds) once another 
change is made to the query. 

Initial Save Dialog Checkbox states Specify your preference for the initial value 
of the following save time options: 

Query Verify: the Query Verification dialog 
is displayed at save time. 

G-group Orientation: G-groups containing 
fragments must have their fragment 
orientation specified when a G-group 
contains 2 fragments and has two points of 
attachment to the core structure.   

Refine Using Structure Filters: Structure 
filters and screens interface will be invoked 
at save time. 

Advanced Save all Chain Atoms as Ring/Chain: all 
chain atoms are set to Ring/Chain when 
saved. 

Save all Chain Bonds as Ring/Chain: all 
bonds are set to Ring/Chain when saved. 

Save all Terminal Atoms as Ring/Chain: 
all terminal chain atoms are set to 
Ring/Chain when saved.    

Select chain atoms/nodes to save as 
Ring/Chain: manually select atoms and/or 
bonds to be saved as Ring/Chain.   
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Structure Preferences: Colors/Fonts 

Option How it works... 
Colors Click on one of the items and then select a color from the color 

palette. Changes will be displayed in the sample window. 
Fonts: Text Font = Atom 
Font 

When this option is checked, the font that has been selected for 
Atom symbols will also be used for Text characters. Uncheck 
this option to change the font used for Text. Click the 
appropriate font button to select the font, size, and style. 

 
 
Structure Preferences: Drawing 

Option How it works... 
Double Bond Width 
(Pixels) 

Allows you to specify the distance between double bonds. It 
only takes effect on printing. 

Pen Width (Pixels) Allows you to set the thickness of bonds. It only takes effect on 
printing. 

Grid Spacing (mm) Allows you to specify the default distance between grid lines. 
The Grid box must be checked for the Grid to be displayed. The 
grid is most useful for drawing when grid spacing either 
corresponds to a fraction of bond length or is equal to bond 
length. 

Compass Interval (deg) Allows you to specify the default compass interval.  Bonds 
drawn from an atom automatically snap to these compass 
intervals when the Snap Bonds option is checked.  

Note that compass intervals used should be factors of 90 
degrees (e.g., 15, 30, etc.); otherwise bonds cannot be drawn 
horizontally and vertically. 

Bond Length (mm) Allows you to set a default bond length which is used for the 
ring and chain commands and for freehand drawing when the 
Snap Bonds option is checked. Snap Bonds must be checked 
to set values for Bond Length. When a value has been set for 
Bond Length all freehand bonds are drawn to that fixed length. 
Bonds are also then drawn to the nearest specified compass 
position. 

Browse Delay (secs) Allows you set the time between displays when browsing 
structure queries. 

Atom Selection This changes the display for the selection of atoms in the Draw 
menu and the Current Atom box (activated by a left click). 

Dialog Box The default dialog for atom selection is displayed on the left and 
all other elements are displayed in alphabetical order.  
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Option How it works... 
Periodic Table Elements are displayed in a periodic table. 
List  Elements, shortcuts and other variables are listed in a scroll 

box. Values can also be entered using the keyboard.  

Note - A right click on the Current Atom box will open with the 
List option. 

Carbons Dots - Causes carbons to be displayed and printed as a fat dot. 

Angles - Causes carbons to be displayed and printed as an 
angle. 

C’s - Causes carbons to be displayed and printed as C. 

Note - Carbon display for individual nodes can be changed by 
pre-selecting the nodes and clicking on the appropriate 
command in the Display menu. The Display menu 
feature is not related to Carbon display button on the 
toolbar or the Carbons preference. 

Reaction Help When this option is checked, help dialogs are provided when 
the Reaction Role and Reaction Site Tools are initially selected. 
This option is recommended when drawing reaction queries. 

Grid Turns a grid on which may act as a guide when drawing a 
structure. The grid line spacing can be changed using the Grid 
Spacing option. 

Ring Circles Draws circles inside normalized rings (replacing the alternating 
single and double bonds).  

Note that refreshing the screen display is slower when ring 
circles are displayed, so it is faster to draw structures with this 
option unchecked and then check it before printing. 

Snap Bonds Allows you to specify the bond length that will be used for 
drawing rings and chains. Bonds drawn freehand will 
automatically snap to the nearest compass interval at the bond 
length that you specify. If this option is unchecked the standard 
bond length built into the program will be used for drawing rings; 
chains and bonds drawn freehand will be drawn using the 
length and orientation indicated by the cursor position. 

Delete Atoms with Bond Allows you to specify that the atoms at either end of a bond will 
be deleted when a bond is deleted, assuming there are no other 
attachment to the atoms. 
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Creating Reports and Tables 

Reports and Tables Overview 

STN Express provides the following tools for creating reports or tables: 

• Custom Report Tool for creating a report containing only desired transcript data with 
customized formatting. 

• Custom Table Tool for creating a table of selected data from a transcript with customized 
formatting. 

• Predefined Report or Table Tool for creating a report or table with predefined content and 
formatting. 

 
Creating Custom Reports and Custom Tables 

Creating Custom Reports 

Create a custom report when you want to specify the content and the formatting for a report. 

To create a custom report:  

1. Click the Custom Report button on the toolbar of the STN Express Main Menu or the 
STN Online and Results window. You may also access the tool from Results on the STN 
Express Main Menu or from the File menu of the STN Online and Results window.  

2. The Report Tool window opens.  Select from the buttons on the left side of the Report 
Tool window.  Alternatively, use the Next and Back buttons to move sequentially among 
screens.  When selected, each button displays a screen with options for you to choose. 
Once the transcript(s) are chosen, you can click the buttons for different screens in any 
order. 

Button Function 
Transcript(s)  Select one or more transcripts for the report 
Template  Select a template for the report from those previously 

saved 
Content  Select which answers and transcript components to include 

in the report 
Fields  Select and format the fields to include in answers 
Highlighting  Customize highlighting of terms in the report 
Cover Page Define the content and format for the optional cover page  
Header/Footer  Define the content and format for the optional header or 

footer 
Statistics  Create charts for the report based on data from fields in the 

transcript(s) 
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The Report Tool window also includes the following buttons on the bottom of the window: 

Button Function 
Save Template  Save current configuration as a custom template for future 

 reports 
Preview Open preview page for the report 
Finish  Produce the report once all content and style selections 

have been made 
Back  Go back to a previous screen 
Next  Go to the next screen 
Cancel  Cancel the report creation process 
 
 
Creating Custom Tables 

To create customized tables of selected data from answers in your transcripts, use the Table 
Tool.   

For example, you may create tables with: 

• Substance names, molecular formulas, and structures from the Registry file 
• Titles, patent assignees, and IPCs from patent records 
• Patent information, titles, and graphics  

You may access the Table Tool from:   

• The toolbar of the STN Express Main Menu or the STN Online and Results window 
• The Results menu of the STN Express Main Menu 
• The File menu of the STN Online and Results window. 

The Table Tool window is displayed.  To create a table from answers in your transcript, select 
from the buttons on the left side panel of the Table Tool window.  When selected, each button 
displays a window with options for you to choose.  

The Table Tool window contains the following buttons: 

Button  Function 
Transcript(s)  To select transcripts for the table 
Template  To select a template for the table 
Content  To define the content of the table 
Fields  To select the fields (from answers 

displayed) to include in the table 
Highlighting To define highlighting in the table 
Cover Page  To define the content and format of a cover 

page  
Header/Footer  To define a header and/or footer for the 

table 
Statistics  To define charts from data in the 

transcript(s)  
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The Table Tool window also includes the following buttons on the bottom of the window 

Button  Function 
Save Template  To save a template for tables 
Finish  To produce the table after all content and 

style selections have been made.   
Back  To go back to the previous screen 
Next  To select the next screen 
Cancel  To cancel the selections on a screen 
 
 
Selecting Transcripts for Reports or Tables 

When you select the Report Tool, Table Tool, or Predefined Report tool, a window listing the 
path for the most recently used transcript is displayed by default.  

Highlight the path and then click the Remove button on the right if you do not want to select this 
transcript for your report. 

Click the Browse to Add button on the right to locate other transcripts. 

You may select multiple transcripts for a single report. 

 
Selecting a Template for a Custom Report or Table 

Click the Template button of the Report Tool or Table Tool to see a list of names for any report 
templates that you have defined and saved.   

Report and Table templates display separately.  To view both Report and Table templates, 
choose the All radio button.  

To locate templates that are not in the default folder, click the Change Folder button and 
navigate to that location.  Click Delete to delete the highlighted template. 

Click Choose Template to select the highlighted template for this report. 

If no template is chosen, STN Express sends a prompt for verification. Click Ignore to continue to 
define a custom report. 

 

Defining the Content of Custom Reports or Tables 

In the Content tab of the Report Tool or Table Tool, you may select parts of the following 
information from your transcript: 

• Session Information 
• Command Information 
• Data Information 
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Click in the appropriate boxes to include this content.   

Select Summary page and Summary Options if you want to include a hyperlinked summary of 
answers at the beginning of your report.  

If Answers is checked in the Data Information section, the window on the right displays the L-
number(s) and the number of answers to be included for each L-number. Click the box with a plus 
sign to expand answer detail for each L-number. Uncheck the box for an answer if you do not 
want to include it in your report. 

Click Check All under a section to include all content.  Click Uncheck All to reset all boxes to 
empty. 

You also have options to: 

• Place each TIFF image on its own page 
• Include checkboxes in display 
• Include checkboxes in print 

Click Format Report Comments to set formatting for any comments that you will add to the 
report.   

When the Report Tool or Table Tool is used again, the previous content selections are recalled.  

 

Creating a Summary Page for a Report 

You can create a summary page containing up to 6 fields for each answer in your custom report. 
The first field selected is hyperlinked in your report, making it easy to find the complete record in 
the report.  

To create a summary page, check Summary page and click Summary Options in the Content 
window of the Report Tool.  

Select up to 6 fields from a list or pull-down options on the Summary Fields screen.  Click one of 
the radio buttons: Bibliographic, Substance, or Other to view options for the type of answers in 
your report. 

 

Selecting Fields for Reports or Tables 

Select the Fields tab of the Report or Table Tool. 

Only the fields in the transcript are listed in the Field Name pane; they are listed in the same 
order as the order of their display in the transcript.  A blank Selected Fields pane is displayed on 
the right.  
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Use the buttons in the middle of the screen for selecting the fields: 

Button Function 
Insert  Insert any highlighted fields from the Field Name list into the 

Selected Fields list 
Insert All  Insert all the fields from the Field Name list into the Selected 

Fields list 
Move  Move the highlighted fields up or down in the Selected 

Fields list 
Remove  Remove any highlighted fields from the Selected Fields list 
Remove All Remove all the fields from the Selected Fields list 

Check the box for Remove duplicate fields within an answer to remove duplicate fields.  

You may select the order of the fields in the Field Name pane as: 

• Alphabetical 
• Transcript - the order in which they appear in your transcript 

To change the format of any of the selected fields, highlight the field(s) in the Selected Fields 
pane.  Multiple fields may be chosen by using the Shift or Ctrl keys.  Select from the formatting 
options that are displayed.  

Six patent-related fields display additional tabs for formatting.  The fields are: 

• Application Information 
• Patent Information 
• Priority Application Information 
• Individual AI 
• Individual PI 
• Individual PRAI 

The tabs are: 

• Subfields - include/exclude subfields of the field in the report 
• Other - control the maximum number of rows per answer, the countries to be included, 

handling of blank cell, handling of family members. 
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Defining Highlighting in Reports or Tables 

The Highlighting window of the Custom Report or Table Tool wizards shows the following options: 

Highlighting option selected  Result  
Highlight Hit Terms  Hit terms are highlighted in red by default. 

 Click the Don’t Highlight the Following 
Hit Terms check box and enter the 
applicable terms in the box below if you do 
not want all hit terms highlighted. 

Highlight the Following Terms  Type the terms to be highlighted, separated 
by commas.  

Highlight Terms in this Text File Highlight a list of terms saved in a text file. 
Browse for a saved file. Click Format to 
change the font and/or the color for 
highlighting. 

Click Format to view the options for changing the font and/or the color of highlighting. 

Truncation may be applied to terms in the Hit Terms and Additional Terms input boxes.  The 
truncation rules are:  

• "?" represents any number of characters 
• "#" represents zero or one character 

 

Creating Cover Page for Reports or Tables 

To create a cover page:  

1. Check STN Express Cover Page on the Cover Page screen if you want to create a 
cover page for your report.  Select Attach File if you want a file with an existing cover 
page to print with your report.  

2. Choose the content of your cover page by selecting from the options on the left, e.g., 
Title. 

3. Click the Order tab to change the order of appearance of the selected items on the cover 
page.  Highlight the item and move it with the up and down buttons.   

4. Click the tab for each desired selection, e.g., Title, to enter or modify the existing 
information and default format for the selection. For example, when you click the Title 
tab, the default title, consisting of the names of the transcripts, is displayed in the default 
font and size.  You may modify or replace the text and select the Format button to 
change the font. 
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Adding Headers and Footers to Reports or Tables 

The Header/Footer screen allows you to add headers or footers to your report.   

Click on the Header or Footer tab and then define the content for the left, center, and/or right 
areas of the header and/or footer.   

For example, you may define the footer as a centered, attached image.  Select Image File 
Attachment from the options under Center.  Click Select to select the file with an image.  The 
image is displayed in the Preview box.  The header or footer is visible in Print Preview.  To shift 
the location of the header or footer on the page, change the margins for the page. 

 
Statistics for Creating Charts for Reports or Tables 

You may create up to three histograms or pie charts from the transcript as part of your report or 
table.  

Choose one field for each histogram or pie chart. You may also choose to display the graphs at 
the beginning or at the end of your report.  

Choose Include Other if you want to include all instances of the field, including the least 
frequently occurring terms that will be grouped together and labeled Other in the histogram or pie 
chart. 

 

Previewing Reports and Tables 

You can preview your report or table any time.  Simply click the Preview button. 

A preview of 10 answers is displayed in another pane.  Click the radio button Portrait or 
Landscape to change the view.  

Click Update Preview when a parameter is changed to get an updated view.  Click Hide Preview 
to hide the preview pane. 

 
Editing Custom Reports or Tables 

After a custom report or a table is generated, you can edit any of the parameters. Select Edit 
report or Edit table from the Edit menu of the STN Online and Results window. Make the 
necessary changes and click Finish to regenerate the report or table. 
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Adding Comments 

To add comments about a specific record in a custom report or table, click Add Comments on 
the right side of the record.  Enter your comments in a box and click OK. Your comments appear 
in a box under the answer number line.  Click Edit Comments to change them.  Click OK when 
you are done. 

To change the default format for comments, select Format Report Comments in the Content tab 
for Custom Reports or Tables.  

 

Predefined Reports and Tables 

Creating Predefined Reports and Tables 

Use the Predefined Report tool to quickly create a formatted report or table from a transcript (.trn 
or .rtf file using predefined content and formatting.  

To create a predefined report or table: 

1. Click the Predefined Report button on the toolbar of the STN Express Main Menu or the 
STN Online and Results window.  The report and table tools can be used when you are 
not in an active online session. 

2. Select from the following options for types of predefined reports or tables: Patents, 
Journals, Patents and Journals, Substance Report, Substance Report with 
Properties, Substance Table, Substance Table with Properties.  

3. The Transcript File dialog is displayed.  Select the transcript file for your report.  Click 
Open.  A predefined report is automatically displayed with all the applicable records from 
your transcript. 

If any records are unable to be processed for the predefined report or table due to lack of needed 
content, a pop-up warning box is displayed. 

 
Requirements and Output for Predefined Reports and Tables 

Predefined Patent Report 

For an answer to be recognized in a transcript and appear in a predefined patent report, it must: 

• be from a file containing patents 
• have a PI (Patent Information) field 

Data items included in a patent report (if present in the transcript) are:  

• Accession Number, Title, Patent Assignee, Source 
• Language, Abstract, Technology Focus, Graphics, Inventor(s), Assignee(s), International 

Patent Classification, Application Information, Priority Information, Patent Information, 
Indexing Terms, Hit Structure (These items may be removed when you customize the 
content of reports).  
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Predefined Journal Report 

For an answer to be recognized in a transcript and appear in a predefined journal report, it must: 

• Have a TI (Title) field and an AU (Author) field 

Data items included in a journal report (if present in the transcript) are: 

• Title, Author, Accession Number, Corporate Source, Journal Name 
• Language, Abstract, Graphics, Indexing Terms, Hit Structure (These items may be 

removed when you customize the content of reports).  

Predefined Patent and Journal Report 

For an answer to be recognized in a transcript and appear in a predefined patent and journal 
report, it must meet the requirements for either a predefined journal report or a predefined patent 
report.  

Predefined Substance Report  

For an answer to be recognized in a transcript and appear in a predefined substance report, it 
must:  

• Include data from substance-based files, e.g.,  REGISTRY, CHEMCATS, CHEMLIST, 
GENBANK, REAXYSFILE 

• Have a CN (Chemical Name) field  

Data items included in a Predefined Substance Report (if present in the transcript) are:  

• Chemical Name, CAS Registry Number 
• Structure Diagram, Molecular Formula (These items may be removed when you 

customize the content of reports).  

Predefined Substance Table 

For an answer to be recognized in a transcript and appear in a Predefined Substance Table, it 
must:  

• Include data from substance-based files, e.g., REGISTRY, CHEMCATS, CHEMLIST, 
GENBANK, REAXYSFILE  

Data items included in a Predefined Substance Table (if present in the transcript) are:  

• Structure Diagram, CAS Registry Number, CAS Index Name, Molecular Formula (These 
items may be removed when you customize the content of reports).  

Predefined Substance Report or Table with Properties 

A Predefined Substance Report or Table with Properties includes substance and property data. 
Use the CALC, EPROP, or PROP display formats in REGISTRY. 
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For an answer to be recognized in a transcript and appear in a Predefined Substance Report or 
Table with Properties, it must: 

• Include data from substance-based files, e.g., REGISTRY, CHEMCATS, CHEMLIST, 
GENBANK, REAXYSFILE 

• Have a CN (Chemical Name) field 

Data items included in a Predefined Substance Report or Table with Properties (if present in the 
transcript) are:  

• Structure Diagram, CAS Registry Number, CAS Index Name, Molecular Formula, 
Predicted (Calculated) Properties, Experimental Properties (These items may be 
removed when you customize the content of reports).  

 
Customizing Content of Predefined Reports and Tables 

You may customize some features, for example, Selected Fields, of a predefined report or table 
while retaining the predefined formatting.   

To customize a predefined report or table: 

1. Select Predefined Reports and select type of report or table, e.g., Patents.  Select Edit 
Default Format from the submenu.  

2. Select the transcript file. 
3. The Table (or Report Tool) opens.   
4. Click the Fields tab. The Selected Fields pane displays all the fields preselected by the 

Predefined Reports Tool.  

You may customize the report by using all the Fields tab options to insert, move, or remove fields, 
as well as to format any highlighted fields. 

 
 
Selecting or Deleting Answers in Reports 

After a predefined or custom report is generated, you may select individual answers to be 
included in or deleted from the report. 

Follow these steps: 

1. Each record in a report is preceded by a selection box. Click on the selection box to mark 
this record. 

2. From the File menu select Delete Marked Answers or Save Marked Answers.  
3. Another Report window opens, showing only the saved answers or excluding the deleted 

answers depending on which option you chose. 
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Saving Reports or Tables 

To save a report or a table:  

1. Select Save As from the File menu. 
2. The Enter Filename dialog is displayed.  Type the name of the file in the File name box. 

 In the Save as type box, choose the type of file for saving.   
3. Click Save. 

Custom reports may be saved in the STN Express .rep format, and custom tables may be saved 
in the STN Express .tbl format.   

In addition, you may save reports and tables as the following types of files: 

• Excel Files (*.xls) 
• RTF Files (*rtf) 
• ASCII Text (*.txt) 
• HTML Files (*.htm) 
• PDF Files (*.pdf) 

Please note that headers and/or footers are not preserved when a file in the STN Express .tbl 
format is converted to an Excel *.xls file. 



Variable Group Analysis 

Variable Group Analysis 

Overview of Analyzing Variable Groups 

With STN Express you can create a Variable Group (R-group) Analysis Table that identifies the 
common structure for an answer set of structurally related substances from CAS REGISTRYSM 
with variable R-group locations identified using the R-Group Analysis Table Tool. 

The process of analyzing variable groups consists of two parts: 

• Saving answers for R-group analysis 
• Creating R-group analysis table 

 
 
Saving Answers for Variable Group Analysis 

To save answers for R-Group Analysis:  

1. Conduct a search in CAS REGISTRYSM, ZREGISTRY, or LREGISTRY to obtain an L-
number answer set. 

2. Left-click the L-number for the answer set to display a list of available wizards.  Select 
Save for R-group Analysis. You may also select this option from the Select Discover! 
Wizard window or from the options under Discover! button.  

3. Select the substance types to be included or excluded from the R-group file. Click Next. 
4. Select the substance information to include in the Variable Group Analysis table. For 

each answer, the CAS Registry Number is automatically included. Only the fields listed 
may be included in the final table. 

5. Click Next to continue. 

 
 
Creating R-Group Analysis Table 

To create an R-Group Analysis Table from the saved answers: 

1. Select R-Group Analysis Table Tool from the File or Results menu, or from the Toolbar. 
2. Use the File tab of the R-group Analysis Table Tool to preview the R-group file structures 

and select structures of multicomponent substances.  
3. Use the Structure tab to define the common structure and select R-groups to be 

included.   
4. Use the Fields tab to select additional fields to be included.    

The interaction and features for the Template, Cover Page, and Header/Footer tabs of the R-
group Analysis Table are the same as those for the Report Tool and Table Tool. 
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Structure Tab  

The Structure tab of the R-group Analysis Table Tool provides the following options: 

• Defining the common structure  
• Selecting R-groups and deleting attachments for R-groups 

 

 
Selecting R-Groups in Structure Tab  

To preview and select R-groups:  

Check Preview R-group to view the structures for the selected R-group in a pane on the right. By 
default, this radio button is checked. Check or uncheck the box for each R-group to select or 
deselect it for inclusion in the R-group analysis table. By default, all the boxes are checked. 

To delete attachments for R-groups:  

Check Include only answers in which the R-group is attached by the following atom(s): A 
list of attachments for the highlighted R-group is displayed in the box. To exclude answers in 
which the R-group is attached to a particular atom, remove that atom from the list. 

To rename R-groups: 

Click Rename in the Structure window of the R-group Analysis Table. Select an R-group and type 
a new name. Click OK. 

 

 
File Tab  

The File tab of the R-group Analysis Table Tool includes a box to Preview R-group file.  When 
this box is checked, a structure preview pane is displayed on the right.  This pane contains the 
structures for the answers included in the saved R-group file.  Each answer is labeled, numbered, 
and automatically checked to be used for R-group analysis. You may select or unselect each 
answer.  In addition, the following options are available:   

Option Result 
Select All Checks and selects all answers.  
Invert Selection  Selects unchecked answers and deselects checked 

answers.  
Save Selected  Displays a window for saving the selected answers as an R-

group file (.rgp).  
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If an answer contains more than one component, each component is labeled and displayed 
separately.  Single-atom components are labeled as Other components.  Other components are 
not included in R-group analysis. Click the View hyperlink to view the structure of each 
component in a separate window. By default, the first component is selected for R-group analysis. 
Click the radio button for another component to select it for R-group analysis.  Preview all the 
structures to make sure that the desired component structures are selected.   

 
 
Fields Tab  

The Fields tab of the R-group Analysis Table Tool provides a list of additional fields, e.g., CAS 
Registry Numbers that you may include in the R-group Analysis Table.   

Highlight the desired content and click Insert to include the field in the Table. 

By default, the list of Selected Fields for the R-group Analysis table includes: 

• R-group - the R-groups defined for the common structure 
• Structure - the complete structure for each answer  
• Base Structure - the structural skeleton showing the bonding for each answer 
• Other Components - when other components are present, the R-group Analysis Table 

includes not only the structure component whose R-groups were analyzed, but also all 
the other components, including single-atom fragments. 

To remove an item from the Selected Fields, select the item to be removed and click Remove. 

 
 
Defining Common Structure for R-Group Analysis 

You can define the common structure by: 

• Using the largest common structure 
• Using a saved structure query file 

Click the Use the largest common structure radio button and Define Structure to use the 
largest common structure. 

Click Use a saved structure query file and Define Structure to define the common structure 
from a saved query structure. A window with your saved query structures is displayed. Select the 
query structure for defining the common structure in your answer set. 

In addition, check Use structure skeleton, ignore bonds if you want the bonds to be ignored 
when the common structure is defined with either method. 
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Problems with Defining Common Structure for R-Group Analysis 

The R-group Analysis Table Tool may not be able to define a common structure if your R-group 
analysis includes: 

• Substance types that cannot be processed 
• Disparate or dissimilar structures 
• Multi-components in which the selected component is not a match  

Answers that may cause the tool to fail include some polycyclic compounds, large substances, 
and substances that do not include a structure in the CAS REGISTRYSM file. 

To minimize problems with defining common structure: 

• It may be helpful to check the box Use structure skeleton, ignore bonds to define a 
common structure when the answer set contains structures with bond variations. This 
checkbox may be used with either radio button: Use the largest common structure or 
Use a saved structure query file. 

• Exclude alloys, coordination compounds, incompletely defined substances, manually 
registered substances, polymers, and tabular inorganic substances. The Save for R-
group Analysis Wizard provides the option to exclude these types of substances. If you 
have not excluded them, you can go back online, redo your search, and Save for R-
group Analysis.  Alternatively, you can make use of the structure preview on the File tab 
of the R-group Analysis Table Tool to deselect the undesirable answers.  Additionally, if 
you have chosen to display these answers online in the IDE format, you can review your 
transcript to identify these substances. 

• You may try to define your own structure by choosing Use a saved structure query file 
on the Structure tab within the R-group Analysis Table Tool.  To create a saved structure, 
use the structure drawing tool available via Query/Prepare Structure Query.  Isolated 
rings are handled better by the R-group tool than non-isolated rings. 

Note: The R-group tool may alter the structure you provide in order to define the R-
groups. 

• If your answer set includes multi-component substances, the first component is selected 
by default. Within the File tab ensure that Preview R-group file is selected.  Scroll 
through the list of structures and choose the radio button for the appropriate component 
in each answer. 

• If your answer set contains two or more subsets of different substructure types (for 
example if the search was created via a text search), you will need to process your 
answer set prior to creating an R-group table. To accomplish this, ensure Preview R-
group file is selected, check only those answers that have the same substructure and 
use the Save Selected button to create a new .rgp file. (If you have changed your 
component selection in multi-component answers, that selection will not be maintained in 
the .rgp file you create).  Repeat this process as necessary to create additional .rgp files 
from this answer set. 

Note: If you are only creating two .rgp files, it may be useful to use the ”Invert Selection” 
button to generate these two files.  Run the R-group Analysis Table Tool on the newly 
created .rgp file to create a table from that subset of structures. 
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Main Preferences 

Preferences Overview 

There are three types of Preferences: 

• General 
• STN Online and Results 
• Structure Drawing Preferences 

To access all preferences, click the Preferences tool from the Main Menu Toolbar or from the 
Setup menu of the Main Menu. 

 
 
General Preferences 

General Preferences are used to: 

• changing default folders for use in STN Express  
• customize the display of the toolbar 
• select the language that STN Express and related programs use for the display of menus 

and buttons 
• specify your own text editor 

Changing folders 

To change folders where files such as transcripts or queries are place, type the path name in the 
text box for the folder or browse for folder location and select it.  

Customizing the display of the Toolbar 

Select from the following options: 

Option Selected  Result 
Toolbar  Display the toolbar buttons in STN Express 

(default) 
Always on top  Force the toolbar to remain visible at all 

times 
Minimize toolbar on use of editor Minimize the toolbar after using editor 
Tooltips  Control whether the toolbar has tool tips in 

addition to the text on the buttons 

 

Selecting Language 

You may also select the language that STN Express and related programs use for the display of 
menus and buttons.  To use Japanese you must have a Japanese version of Windows.  The 
language setting takes effect as soon as you click OK.  Other STN Express programs that are 
already running must be restarted before the language is changed.  
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Specifying Text Editor 

To specify your own text editor, type or paste the complete path to the editor program in the 
Editor box.  If this box is blank, the STN Express built-in editor is used.   

 
STN Online and Results Preferences 

To access the STN Online and Results Preferences, click Preferences on the Toolbar of the STN 
Online and Results window or the Main Menu and choose STN Online and Results.   

Click one of these tabs to change the preferences: 

• Function keys 
• Online 
• Colors/Fonts/Scaling 
• Links 
• Layout 
• Discover! 
• Account 
• Postprocessing 
• Other 
• User data 
• BLAST 

 
Function Key Preferences 

Use the Function Keys tab to define keyboard shortcuts for frequently used text strings.   

Up to 18 key combinations may be defined, using Shift F1-F9 and Control-Alt F1-F9.  

To define a Shift Function key, click the radio button next to Shift.  Type a text string in any of 
the function key boxes.   

To define a Control-Alt Function key, click the radio button next to Control-Alt.  A new list is 
displayed.  Type a text string in any of the function key boxes. Type [cr] at the end of a line to 
insert a carriage return after each string. 
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Online Preferences 

Use the Online tab to customize your online searching environment. Click the box adjacent to the 
preferences you want to activate. Then click OK. 

Option Selected  Result 
Continuous scrolling Text and graphics scroll without interruption 

(recommended). 
Modifiable queries  Uploaded structure queries may be modified in the 

STRUCTURE command. 
Use filters  Automatically upload structure filters when they are 

available. 
Enable idle time warning Warning message is displayed after no commands are 

sent to STN for 15 minutes. 
File Transfer: Log Packets A log of upload and download (Kermit) activity is 

created. Select only on request by STN support staff for 
problem resolution. 

File Transfer: Long packets 
4000 

Allows faster downloads of TIFF images and other files 
when Kermit is used (recommended). 

Reduce CPU usage when 
Online 

Puts STN Terminal Emulation into a passive mode that 
uses less CPU resources when waiting for you to enter 
data. If this option is not selected, STN Terminal 
Emulation uses all the idle CPU time on your local 
system, without degrading performance of your 
machine. 

Display international characters Allows proper display of international characters when 
you are connected to an online host that supports those 
characters.  This option cannot be used if the 
connection route to the host computer requires the use 
of parity.  If the data display from your online host 
appears to be corrupt, turn this option off.  If the 
problem is resolved, then your connection is using 
parity. 

Autoload command history into 
Command Window 

Command history for the current session is 
automatically loaded at the time you open the command 
window. 

Do not make uploaded structure 
queries ”Read only” 

If an uploaded structure query is displayed in a 
transcript and the query was modified after it was 
uploaded, the transcript will display the query as it 
appears now and not as it appeared at the time of 
upload and search. 

Do not create a file with 
structure query attributes 

Text files with structure query attributes are not created. 

Highlight CA Lexicon terms on 
command line 

CA Lexicon terms are highlighted on the command line 
by either yellow boxes or wavy underlines. 

Create and update personal 
dictionary 

Personal dictionary, consisting of an alphabetical listing 
of your search terms, is created.  These terms may be 
selected for use in SEARCH or EXPAND. 
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Option Selected  Result 
Clear Dictionary Remove all terms from your personal dictionary. 

Options  Opens a Personal Dictionary Options window with 
checkboxes for types of terms to exclude from being 
added to your personal dictionary. 

Use KERMIT to DISPLAY 
images 

Use KERMIT to display images if the preferred method 
(Web Image Server, available in Version 8.4) is not 
available to you  

 

Colors/Fonts/Scaling Preferences 

Click the Colors/Fonts/Scaling tab to define colors and fonts in your online window or Browse 
Transcript window or for prints; to scale structure graphics; and to modify TIFF viewer scale 
settings. 

To change... Do this... 
The color of highlighted text or the color of 
the text you type at a prompt 

Click the radio button adjacent to Highlight 
text or Prompt text, respectively.  Then 
click the color that you want. 

The style of hit terms (your search terms) in 
transcripts, online, or in reports 

Select the style under Highlight style. 

The font of text in the online window or 
browser window or when printing a 
transcript 

Click the Change button in the Display 
Font box or the Printer Font box, 
respectively.  A Font dialog is displayed. 
You may modify the font and point size.   
For display fonts, only fixed-width fonts are 
available.  For print fonts, only fixed width 
printer and True Type fonts are available. 
Proportional fonts are not available because 
text does not line up properly when they are 
used. 

 The structure graphic scaling factors Enter a new scaling factor. The defaults are 
1.0 for both scaling factors. If the two factors 
are not changed proportionately, vertical or 
horizontal distortion will occur. 

The initial scale used by the TIFF Viewer Click the appropriate radio button next to 
the Full, Half, or Quarter option. 

The default post processing font Click Change under Default postprocessing 
font. 

Japanese font Pick the desired font next to Japanese font. 
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Links Preferences 

The Links tab offers the following options: 

Option Selected Result 

Use a single browser for all WWW links  Existing browser window is reused, if it is 
already running. If the browser window is 
not running, STN Express will launch the 
browser (default). 

Launch a new browser window for each 
WWW link  

A new browser window is opened for each 
WWW link, resulting in multiple open 
windows. 

Override Windows default browser  If you have several Internet browsers 
installed, this option allows you to specify 
the path to the one that you prefer. 

Change to STNGUIDE when launching 
BLAST, STN Viewer, or Web browser   

Your online session is moved to the 
STNGUIDE file any time you request a web 
function.  To continue your STN session in 
another file, enter that file. 

Full-text links  Select the STN service center where you 
have your account. Secure may be checked 
for extra security only for access to CAS 
Full Text Options from STN-Columbus. 

STN Login ID embedded in Full-text links in 
transcripts, reports, and tables 

These options specify when your STN Login 
ID may be included in transcripts, reports, 
and tables to authenticate and customize 
the CAS Full Text Options full-text links:   

• Never include: the CAS Full Text 
Options page is never customized 
for the STN login ID.  

• Always include: the CAS Full Text 
Options page is always customized 
for the STN login ID.  

• Prompt when Creating Report or 
Exporting a Transcript: you will be 
prompted whether your STN Login 
ID should be included. 

• Prompt at capture session: you 
will be prompted at capture session 
whether your STN Login ID should 
be included. 

Enable STN Links  Selected items are hyperlinked when you 
are logged on to STN. 

Return to original file after executing links Return to original file after links are 
executed. 
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Layout Preferences 

Use the Layout tab to customize the layout of your STN Online and Results window.  

Option Action 
Status bar  Select the items to display in the Status Bar 

located at the bottom of the STN Online and 
Results window.  

Show Toolbar  Select to show the Toolbar 
Open Command Window in locked mode  If locked mode is selected, you can enter 

multiple commands in the Command 
Window before sending them to the host. If 
locked mode is not selected, the Command 
Window opens in Send mode, which sends 
a command directly to the host when a 
carriage return is pressed. 

Show Select Discover! Wizard Window  Deselect if you do not want the window to 
be displayed. 

 
 
Discover! Preferences 

Option Selected  Result 
Suppress background display of Discover! 
commands  

STN commands generated by Discover! 
wizards are not displayed in the session 
window until the wizard function is 
completed. 

Edit Alert L-number deletion warning  Warning is displayed when a deletion of an 
L-number used in an SDI alert is requested. 

Return to original file after closing a wizard  Online session returns to the original file 
after a wizard function is completed.  

Reset all Wizard introductions windows to 
default (display) 

Click RESET to reset all wizard introduction 
windows to default (display). 

Activate uploaded structure queries in  Uploaded structure queries are activated in 
LREGISTRY by default. You may select 
another structure-searchable file in which to 
activate uploaded structure queries. 

 

Account Preferences 

In the STN Account Type box, select the type of account you have and its features: 

• Commercial (Full access) - default setting 
• Full Academic (Full access w/o discount) - if you have access to STN files under your 

academic program 
• CAS Academic (CAS files only) - if you have access to CAS discounted files only 
• FIZ Academic (FIZ files only) - if you have access to FIZ discounted files only 
• CAS & FIZ Academic (CAS and FIZ files) - if you have access only to CAS and FIZ files 

under your academic program 
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• DERWENT subscriber - if you have a DERWENT subscription 
• GMELIN97 subscriber - if you have a GMELIN97 subscription  
• REAXYSFILE subscriber - if you have a ReaxysFile subscription  

Under Display AnaVist WPI family answers in, enter another database if you do not want these 
answers to be displayed in WPINDEX by default.  

Under Property Data Databases, select the property databases that the Discover! wizards are 
authorized to access. 

Under Spectra Data Databases, select the spectra data databases that the Discover! wizards 
are authorized to access. 

 
Postprocessing Preferences 

Option Selected  Result 
Capture at logon  Transcript is automatically captured at logon 

(default). 
Capture as RTF  Transcript is captured in Rich Text Format. 
Confirm Transcript Capture Stop  Confirmation message is displayed if you 

stop capture of transcript (default).  
Wrap Abstracts in Export  Text of abstracts is automatically wrapped in 

RTF transcripts (default).  
Use fixed-width fonts on non-wrapping 
fields in reports and tables  

Tabular STN data, e.g., patent family 
information, line up in reports and tables 
(default).  

Enable Full-text links in reports and 
exported transcripts  

Full-text links are preserved in reports and 
RTF transcripts (default. 

Combine Author and Inventor in reports and 
tables  

Combine author and inventor data in reports 
and tables (default). 

Combine Patent Assignee and Corporate 
Source 

Combine patent assignees and corporate 
source in reports and tables (default). 

Autosave Transcript  Transcript is periodically saved for a 
specified number of minutes, while you are 
online.   

Uninvert chemical names in predefined 
substance reports and tables  

Keep inverted names in predefined 
substance reports and tables. 

Split Hit Structures from graphics in reports 
and tables  

Separate Hit Structures from graphics in 
custom reports and tables. 

Export answer checkboxes to RTF or PDF Checkboxes are saved in reports that are 
saved as RTF or PDF. 

Symbol characters  Symbols and special characters, e.g., Greek 
letters, display as symbols or special 
characters in reports, tables, and transcripts 
(default). 
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Option Selected  Result 
Expand abbreviations  CAS standard abbreviations are 

automatically expanded in transcripts, e.g., 
”oxidn.” is expanded to ”oxidation”  (default). 

Launch Excel when saving as Excel  Microsoft Excel (the application associated 
with .xls files) is launched when a file is 
saved in Excel format (default). 

Launch Word when saving as RTF  Microsoft Word (the application associated 
with .rtf files) is launched when a file is 
saved in RTF (default). 

Export one report answer per page  Export one report answer per page. 
Export reports and tables direct to file  Useful when you want to create RTF without 

creating a .rep file for example. 
Include L# in Table Answer Field  L-numbers are included in Table answers.  
Autofit tables  Optimal fit of data in tables is achieved. 
Combine Table PN and Kind Patent number and kind code are included 

within a single cell in patent-related tabular 
display of patent information.  

Export Graphics to single Excel cell If this option is checked, all the graphics for 
an answer are placed within a single cell.  If 
this option is not checked, each graphic for 
an answer is placed in a separate cell.  

Cover Page title from template The title on the STN Express report cover 
page is saved in a template. 

Use Groupings Use the groupings, i.e., standardized 
Company names generated within Analyze 
Plus, in the report.  

 
 
Other Preferences 

Option Selected  Result 
Issue warning when requesting all answers 
using ’1-’ 

Warning is displayed when a Discover! 
script contains the TOTAL display option 
requesting a display of all answers from an 
answer set. 

Issue cost notification before display 
commands exceeding 

A cost notification is displayed before a 
Discover! script or a wizard would exceed 
the cost limit you have set for answer 
display.  

Issue cost notification before search 
commands exceeding 

A cost notification is displayed before a 
Discover! script or a wizard executes a 
search command that would exceed the 
cost limit you have set. 

Search SciFinder CAplus answers in Choose an STN file in which imported 
SciFinder CAplus answers should be 
searched. 

Shut off automatic updating of support files  Check the box if you do not want automatic 
updating of support files  
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User Data Preferences 

Under this tab, you can enter information that appears on the cover page of reports and tables. 
This information is also used to identify you when you click Request Help on the Help menu in 
order to send a message to your STN Service Center. 

 
BLAST Preferences 

Preference Description 
Select type of firewall  If you have a firewall or proxy server, it must 

permit a secure HTTP connection. Select 
HTTP or Socks, and enter the proxy server 
name or address and communications port. 

Maximum number of alert result sets to 
keep per profile 

You may keep a maximum of 20 sets of 
CAS Registry BLAST alert results per 
profile. If you run an alert and you reach 
your maximum number of alert results, the 
oldest alerts results are deleted 
automatically. 

Favorite Locations Specify your favorite directory to read 
sequences into BLAST and your favorite 
directory to save results from BLAST. 

Maximum No. of concurrent Reports The maximum number of BLAST reports 
that you may view at the same time. The 
range is 1-4 and depends on the amount of 
memory and processor speed on your PC. 

Use id/pw from existing STN setup If this option is selected, log on to BLAST 
uses the STN login ID and password from 
an existing STN logon setup that you select. 
If this option is not selected, you receive a 
prompt for this information every time you 
log on to BLAST. 

Use wizard when getting STN Sequence or 
Reference records (not both) from BLAST 

When this option is selected, and you use 
the Get STN Data function in BLAST, the 
Discover! refine and display wizard is 
invoked for either Sequence records (i.e., 
the Registry file) or Reference records (i.e., 
CAplus). 

E-mail address for CAS Registry BLAST 
Alerts 

Enter the email address to be used for e-
mail notification of availability of CAS 
Registry BLAST Alert results. Enter the 
email address before setting up a CAS 
Registry BLAST Alert. There is no option for 
entering an email address within the CAS 
Registry BLAST Alert interaction. Note that, 
for a single STN login ID, you may use only 
a single email address for notification of 
alerts. A change in email address for 
BLAST Alerts affects all Alerts for that login 
ID, i.e., both existing Alerts and newly 
created ones. 

 



CAS Registry BLAST Overview 

CAS Registry BLAST Overview 

For information about how to search using CAS Registry BLAST, visit 
http://www.cas.org/express/help/v7/blast/expblast.htm. 
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Access to the Merged Markush Service from Questel 

To access the Merged Markush Service (MMS) via STN Express, follow these steps: 

1. Launch STN Express.   
2. Click on the Setup button on the toolbar of the STN Express Main Menu and select New. 

Create an STN Express setup to access Questel.  For  logon setup information for 
Questel, visit STN Express Technical Support on Merged Markush Service (MMS) setup 
at:  http://www.cas.org/support/stnexp/tsupp/exp80/mmssetup.html 

3. Log on using the Setup created for Questel.  Capture session to create a transcript of 
your session.   

4. Type MMS text commands to create a structure query, or retrieve a saved file with all 
commands listed.   

5. Type the ’VE’ command for query verification.  The MMS viewer opens in a new window 
to display the query. 

6. Click Exit to close the viewer.  The graphic image of the query is inserted into the online 
session.  Note the hyperlinked ”MMS Display” above the query.  Click on that link to re-
open the viewer with the query.   

7. Type ’FI’ to finish, then ’RE’ to initiate a structure search. Generally an Atom-by-Atom 
search is also done. 

8. When the search is completed, use ’VI’ to display answers.  The viewer will open and 
display the first selected answer. 

9. Click Exit to close the viewer and return to the main window.  Note that graphic images of 
the structures selected for display have been inserted into the online session.  
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Using Scripts 

What is a 
Script? 

A script is a text file that contains a set of statements in the STN Express 
with Discover! Script Language that are executed by STN Express. The 
STN Express Script Language can be used to create:  

• custom logon procedures 
• custom search strategies 
• procedures to automate repetitive search or display tasks. 

For example, you may routinely perform a certain subject or author search 
on STN. Rather than logging on to STN and opening a transcript file to 
capture search results, searching multiple files, and then logging off and 
reviewing the transcript, you can use scripts to streamline the process. 
One script can log you on to STN, another can initiate the searches, and 
another script can display your answers. Alternatively, one script can 
perform all three tasks. Because the script runs automatically, without 
waiting for you to type, you may reduce your online time and costs. 

 

Steps in 
Defining a 
Script  

Define what you want to accomplish and the steps required to accomplish 
the task. For example, suppose you have a list of CAS Registry Numbers 
(RN) and want to display their records on STN. What steps would you 
follow? 

A.  Define the task 

1.  Log on to STN. 
2.  Enter the Registry file. 
3.  Display the record for the first RN. 
4.  Repeat step 3 until finished. 
5.  Log off STN. 

B.  Translate the steps into Script Language statements that will 
accomplish the task. 

1.  Log on to STN. 

The script could log on to STN, but it is often better to separate the 
logon task from the job the script performs. In this example, log on 
to STN as usual and then run the script. 

2.  Enter the Registry file. 

The STN command to enter the Registry file is FILE REGISTRY. 
To use an STN command in a script, use the => (arrow prompt) 
statement: 

=> FILE REGISTRY 
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3.  Display the record for the first Registry Number. 

To display a record on STN, use the DISPLAY command. Again 
we use the => statement: 

=> DIS 50-00-0 

4.  Repeat step 3 until finished. 

Add more DIS commands. 

5.  Log off STN. 

End your STN session with the LOGOFF command, again using 
the => statement: 

=> LOG Y 

Creating a 
Script 

To create a script, select Prepare Command File from the Query menu 
on the STN Express Main Menu. Click New in the Open Script dialog. This 
opens the STN Edit window with an Untitled text window inside it. Type 
the following script statements: 

\* Display CAS RNs in the Registry file on STN. 
=> FILE REGISTRY 
=> DIS 50-00-0 
=> DIS 7777-77-7 
=> LOG Y 

Saving the 
Script 

To save the script file, select Save from the File menu. Type a name in the 
File name box and click Save. By default, the script file is saved to the 
User Scripts folder defined in General Preferences in the Setup menu (on 
the Main Menu Toolbar). 

Do not use any name that exists in the Predefined Scripts folder unless 
you are replacing the functions of that script. 

Checking 
the Script 
for Errors 

To check the script for syntax errors, go to the Utilities menu in STN Edit 
and select Check Command File. If errors are found, STN Edit highlights 
appropriate script lines and displays a message at the bottom of the STN 
Edit window. To learn the nature of the error, move the mouse pointer over 
the highlighted part of a line. Correct the error, save the script, and check 
the script again until no errors are found. 

Check Command File does not find all errors because some errors 
cannot be found until the script actually runs. It is not necessary to be 
logged on to an online host to use Check Command File. 
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Script 
Language 
Components 

The STN Express Script Language is a miniature computer 
programming language. As such, it has many of the same components 
as other programming languages. The components of the Script 
Language include: 

Component  Content 
Variables Temporary storage places for 

data, or places to store data 
that can change 

Character Strings and 
Numbers 

Constant, literal text and 
numeric data 

File Names Names of transcript or data 
files on your PC 

Labels Identifiers for statements 
Statements Instructions to STN Express 

that perform an action. For 
example, the SEND statement 
instructs STN Express to send 
a string of characters to an 
online host or communications 
device. 

Operators and Conditions Elements that manipulate and 
compare pieces of data. 

Syntax Requirements Rules for organizing scripts 
and typing statements.  

 

Variables A variable is a name for a place to store information. Specifically, a 
variable can store a number, a string of characters, a file name, or the L-
number result of a search. Use a variable when a specific value is 
unknown or will change within a script. For example, if you write a script 
that performs an author search, make the script flexible by using a variable 
for the author’s name instead of typing the author’s name in the script. 

Variables are named with an underscore followed by one to twelve 
alphanumeric characters. They are considered "declared" after their first 
use. Once a variable is declared, the same name may not be used to refer 
to another variable. 

Variable names are not case-sensitive. For example, the variable named 
_var  is the same as the variable named _VAR. 

Variables are always considered to be of type string (text), except for 
variables that represent search results (L-numbers). Variables are 
automatically converted to numbers (integers) when necessary for 
arithmetic operations or conditions. Attempts to perform arithmetic 
operations on non-numeric text result in errors when the script is run. 
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To give a variable a value, use an assignment statement or the \> 
operator, described at the => statement. See also the # operator, 
explained under the => statement.  

Up to 200 variables are permitted within a script. If there are more 
variables, this is noted when you run the script online rather than when you 
use Check Command File. 

Variable values may not exceed 255 characters in length. 

There are predefined logon setup variables and predefined STN variables. 

 

Character 
Strings 

Textual data is enclosed in double quotes and can be a string up to 140 
characters long. 

You may continue a string on a new line by typing a backslash, \, at the end 
of the line. 

To use the value of a string variable, type the variable along with the text. 
Place double quotes around the entire string. 

For example: 

  _s = "how to use" 

  ECHO "This is _s a variable in a string." 

displays: 

This is how to use a variable in a string. 

Variables within strings are replaced by their values, converting integers to 
text. The # operator, along with a variable, is replaced by the number of 
answers in the answer set and is converted to text. 

If you want a variable within a string to be immediately followed by non-
blank text, separate the variable name and text with a period. 

For example: 

  _variable = "con" 

  ECHO "This example string includes  

  _variable.catenated text" 

displays: 
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This example string includes concatenated text 

Special characters and escape characters within strings are: 

[CR] Carriage return 
[TAB] Move to next tab position 
[BS] Backspace 
[ESC] Escape 
[BELL] Sound bell (beep) 
[CTRL-A]...[CTRL-Z] Unprintable control characters 
[FF] Form feed 

Note that many networks and STN Express use control characters in normal 
operations. As a result, indiscriminate use of control characters may result 
in lost data, locked sessions, or terminated processes. 

The characters _, \, ", [, and # have special use within the script language 
and must be doubled if they are to be used within a string. In other words, to 
include a [ in a string, use two in a row: 

  ECHO "Here is a string with a left bracket (i.e., [[) 
in it." 

displays: 

Here is a string with a left bracket (i.e., [) in it. 

A distinction between upper- and lowercase is made when the characters 
are within a string, and the number of spaces between words and letters is 
not ignored. 

 

Numbers The Script Language supports integers; there are no decimals or fractions. 
Type whole numbers in an ordinary way. For example: 

_var = 42 

IF _var < 100 THEN 

To use a negative number, subtract a positive number from zero: 

_neg = -1 \* not allowed 

_neg = 0 - 1 

IF _neg < 0 THEN 
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File Names Enclose file names within angle brackets, < >. All characters within the 
brackets are taken literally, but underscore characters are not allowed. File 
names may be stored in variables. For example: 

 
CAPTURE ON <transcript>  \* a literal file name 
_var = <new script>  \* assign a file name 
                         \* to a variable 
EXEC _var   \* execute a script 
            \* whose name is in _var 
CAPTURE OFF <> 

 

Labels A "label" or "statement label" identifies a line in a script so that other 
statements can refer to that line. Labels are named similarly to variables 
except that they begin with the @ character. The following are examples of 
valid labels: 

@start 

@error 

Refer to the CONTINUE, GOTO, and GOSUB statements for examples of 
how to use labels. 

 

Operators 
and 
Conditions 

Operators and conditions are components of statements. Arithmetic 
operators manipulate the values of numbers. "String operators" work on 
text strings. Conditional operators compare the values of strings and 
numbers in IF statements. Compound conditions are built with logical 
operators. Special operators are used in specific situations. 

Arithmetic 
Operators 

Use the arithmetic operators in assignment statements to perform 
arithmetic on numbers. The arithmetic operators do not function inside 
strings or conditions. 

+ addition add two numbers 
- subtraction subtract one number from 

another 
* multiplication multiply two number 
/ division divide one number by another  

String 
Operators 

+ concatenation join two strings (not inside 
double quotation  marks) 

. concatenation denote the end of a variable 
name inside double quotes  
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Conditional 
Operators 

To control execution of a statement or a set of statements based on the 
value of a variable, use an IF statement with a condition. A condition 
compares the values of two variables or a variable and a literal number or 
literal string. 

All operators are binary, and the general syntax is A operator B. 

If both operand A and operand B are integers, comparison is based on 
their numerical values. Otherwise, an alphabetic comparison is made. 

All string comparisons are case-sensitive. That means "salt" is not equal to 
"SALT". 

Numbers and Strings 

= equality numbers or strings are equal 
<> inequality numbers or strings are not 

equal 

Numbers 

> greater than A is greater than B 
< less than A is less than B 
>= greater than or 

equal 
A is greater than or equal to B 

<= less than or 
equal 

A is less than or equal to B 

Strings 

INCL includes string A includes string B 
NOTINCL does not 

include 
nstring A does not include 
string B 

Example 1 

_s = "string" 

IF _s = "string"             \* True 

IF _s = "string "            \* False 

IF _s = "STRING"             \* False 

IF _s INCL "ring"            \* True 

IF _s INCL "Ring"            \* False 
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IF _s NOTINCL "cow"          \* True 

 
Example 2 

_var1 = 10 

_var2 = 5 + 5 

IF _var2 = _var1             \* True 

IF _var2 <> _var1            \* False 

IF _var1 > 0                 \* True 

IF _var2 < 4                 \* False 

IF _var1 >= 10               \* True 

IF _var1 <= 10               \* True 

Compound 
Conditions 

Compound conditions may be formed from multiple conditions using 
logical operators. Use parentheses to group and nest conditions up to 
eight levels deep. 

AND logical and both A and B 
OR logical or either A or B or both 
XOR exclusive or either A or B, but not both 

Example: 

_answers = 42 

_dformat = "bib" 

IF ((_answers < 100) AND (_dformat = "bib"))    /* True 

IF ((_answers < 100) AND (_dformat = "all"))    /* 
False 

IF ((_answers < 100) OR (_dformat = "ide"))     /* True 

IF ((_answers < 15) OR (_dformat = "ide"))      /* 
False 

IF ((_answers < 100) XOR (_dformat = "bib"))    /* 
FALSE 

IF ((_answers < 100) XOR (_dformat = "ide"))    /* True 
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Special 
Operators 

\! Edit Edit a command before sending it to an 
online host (=> statement). 

\> L-
number 

Assign the L-number result of a 
command to a variable (=> statement). 

# answer 
count 

Retrieve the number of answers from an 
L-number variable. 

EXISTS file 
existence 

Determine whether a given file exists. 
EXISTS first checks the User Scripts 
folder and then Scripts folder. It sets 
_$filerror to zero if the file exists and to a 
nonzero value if the file does not exist.  

 

Syntax 
Requirements 

The STN Express Script Language has few general syntax 
requirements. However, each statement has its own syntax. 

• More than one statement may appear on the same line, or 
each statement may be typed on its own line. 

• The keywords in the Script Language are not case-sensitive. 
For example, the EXIT statement may be written EXIT or exit. 

• Upper- and lowercase are significant in character strings. For 
example, "Yes" is different from "yes". 

• Blank lines may appear anywhere. 
• Blanks and space characters may appear anywhere. However, 

they are significant in strings (inside double quotes). For 
example, "STNExpress" is different from "STN Express". 

• A line in a script is limited to 80 characters, but a single script 
statement can be 140 characters long.  To continue a 
statement on the next line, put a backslash, \, at the end of 
each line that is continued on the next line. 

• Enclose strings in double quotes. 
• Comments are notes that describe or explain the script, and 

they are ignored by the script processor. Comments begin with 
\* and continue until the end of the line. Comments may 
appear on lines of their own, or they may appear at the end of 
statements. 

• STN commands can be up to 256 characters in length. 

 

Script 
Statements  

The Script Language is composed of "keywords" and "values." Keywords 
are words that have special meaning in the Script Language. Values are 
pieces of data in the form of variables, strings, numbers, or file names. A 
"statement" has at least one keyword, and some statements have 
parameters. A "parameter" is the object of the statement and may be a 
keyword, a value, or a combination of keywords and values. You can 
sometimes think of statements as having verbs and objects. For example, 
in the statement GET _author, GET is the verb and _author is the object 
(parameter). 
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The conventions used to describe the STN Express Script Language are: 

1. Keywords are shown in uppercase letters, e.g., EXIT. 
2. Strings are shown in lowercase letters inside double quotation 

marks. For example, in the statement SEND "string", SEND is a 
keyword, and string is a string value. You may use a variable 
wherever you can use a string. 

3. Variables are shown in lowercase letters with a preceding 
underscore. For example, in GET _var1, GET is a keyword and 
_var1 represents the name of a variable. 

4. Numbers are denoted by lowercase letters. For example, in the 
statement PAUSE n, n represents a number. 

5. Optional parameters are shown inside square brackets. For 
example, PAUSE n [SECONDS] means the PAUSE statement has 
a required parameter, n, and an optional keyword, SECONDS. Do 
not type the brackets when you type the parameter or keyword. 

6. When there is a choice of parameters or values, the choices are 
enclosed in braces, and a vertical bar separates the choices. For 
example, in the statement CAPTURE {ON | OFF}, the keyword ON 
or the keyword OFF follows the CAPTURE keyword. 

7. File names are shown within angle brackets. For example, 
DELETE <file name>. You may use a variable whose value is a 
file name wherever you can use a file name. 

8. Comments are preceded by \* and continue through the ends of 
their lines. The script processor ignores comments. 

9. Example scripts and statements are shown in a fixed-width font. 
10. Script output and results are shown in a bold font. 

Note that a block is either a single statement or a group of statements 
enclosed by BEGIN and END. 

The statements in the STN Express Script Language are listed in 
alphabetical order. 

Make sure you review the common statements SEND, WAIT, =>, :, ECHO, 
IF, GOTO, and EXIT. 

 

Prompt 
Statement 

=> 

: 

=> [host-command] [\!] [\> _var] (primary prompt statement) 

: [STN-reply] [\!] [\> _var] (STN secondary prompt statement) 

The => and : statements, also known as prompt statements, are shortcuts 
for a WAIT/SEND combination. The => command waits for a primary or 
level 1 prompt, "=>" on STN. The : command waits for a secondary or level 
2 prompt, ":" on STN. After the prompt is received, host-command or 
STN-reply is sent to the online host. For example: 

=> del history     \* Send a delete history command 
: y                \* and reply to the secondary prompt  
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is equivalent to: 

SEND ""            \* Cause an arrow prompt.  

WAIT 
  FOR "=>"         \* Wait for the arrow prompt  
SEND "del history" \* and send a delete command.  
WAIT  
  FOR ":"          \* Wait for the confirmation 
question 
SEND "y"           \* and reply.  

In each case in the example, STN Express waits to receive a command 
prompt from STN. After receiving the arrow prompt, STN Express sends a 
delete history command and then waits for a secondary prompt from STN. 
STN responds with "DELETE ALL L# ITEMS? (Y)/N:", which STN Express 
recognizes as a level 2 prompt  

The => statement works for STN and online hosts. The : 
statement is for STN only.  

Use the \! operator if you want to edit the host 
command before it is sent (see also the EDIT 
statement). 

Use the \> operator to assign the L-number result of the command to a 
variable. For example, suppose the search command in the following 
statement produces L2 and 1492 answers:   

=> s acid cow \> _lnum  

The value of _lnum will be "L2". Furthermore, the # operator can be used 
with _lnum to retrieve the number of answers in an L-number. The 
statement:  

ECHO "_lnum contains #_lnum answers."  

displays:    

L2 contains 1492 answers. 
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Assignment 
Statement 

_var = expression 

Use an assignment statement to "assign" a value to a variable. First type 
the name of the variable, then an equal sign (assignment operator), and 
an expression. An expression can be a variable, a string, a number, a file 
name, an arithmetic expression, or a function. For example: 

_count = 0 
_count = _count + 1 
_author = "dittmar, p" 
_filename = <rn.txt> 

 

BEGIN/END BEGIN/END 

BEGIN/END forms a block of statements that are treated as a group. 
BEGIN may appear on the same line as an IF statement. 

A BEGIN/END block usually follows an IF or ONEXIT statement. 

To use this statement, type BEGIN before the statements you want 
grouped together. Type END after the statement group. For example: 

IF (_status = "NOT CONNECTED") BEGIN 
  ECHO "DIALING..." 
  SEND "ATDT 555-5555" 
END 

This example executes every line between BEGIN and END only if the 
value of _status is "NOT CONNECTED". Otherwise, the script continues 
after the END statement. 

 

BREAK BREAK [n [MILSEC[S]]] 

The BREAK statement sends a break to the host system. Enter the 
number, n, as either a variable or an integer. If n is not entered, 750 is the 
assumed value. For example:  

BREAK 500 

sends a break 500 milliseconds in duration. 
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CAPTURE CAPTURE {ON | OFF} <[file name [/A]]> 

The CAPTURE statement turns on or off  transcript capture for your online 
session 

If the CAPTURE ON file already exists, it is overwritten. /A opens the 
transcript in append mode. 

Entering a file name is optional. If you do not enter a file name, you must 
still type <>. CAPTURE ON <> prompts you to enter the transcript file 
name using the standard Capture Session dialog. The Capture Session 
dialog allows you to overwrite or append to an existing transcript. 

Capture may be to a standard STN Express transcript or to an RTF file. To 
capture to an RTF file, include a ".rtf" file name extension. The use of any 
other file name extension, including ".RTF," or no extension at all, results 
in a standard .trn-format transcript. 

CAPTURE OFF <> stops capture. 

For example: 

CAPTURE ON <tranfile> 
ECHO "THIS LINE OF TEXT" 
=> e smith/au 
CAPTURE OFF <> 

results in the line "THIS LINE OF TEXT" and the result of the expand 
command being placed in a file named tranfile in the Transcripts folder 
defined in your General Preferences. 

Capture is turned off when STN Express receives the CAPTURE OFF <> 
statement or when the online session ends. 

If an error occurs, the _$filerror system variable is non-zero. 

 

CLOSE CLOSE 

The CLOSE statement closes the currently open file. For example: 

CLOSE 

closes the data file that was opened by the OPEN statement. 

If an error occurs at the end of the file, the _$filerror system variable is 
non-zero. 
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CONTINUE CONTINUE 

The CONTINUE statement is used to continue processing a script beyond 
the current SEND, WAIT FOR, and TRYAGAIN statements. For example: 

SEND "X" 
WAIT 
  FOR "LOGINID" CONTINUE 
  FOR 20 SECONDS GOTO @ERR 
SEND _loginid 

If "LOGINID" is received from the host within 20 seconds, the script 
continues at the SEND statement. 

 

DELETE DELETE <file name> 

The DELETE statement deletes a specific file. For example: 

_filename = <oldfile.txt> 
DELETE _filename 

deletes the file named oldfile.txt from the Uscripts folder. To delete a file 
from a different folder, give the full path. 

If an error occurs, the _$filerror system variable is non-zero. 

 

DROP DTR DROP DTR 

The DROP DTR statement is used to set the DTR (Data Terminal Ready) 
circuit to an "off" state. In some rare situations, you may need to control 
the DTR setting on your modem. See also RAISE DTR. 

 

ECHO ECHO "string" [NOCR] 

The ECHO statement is used to display a character string or variable on 
the screen. The string can be zero or more characters, variables, or both. 
A carriage return is included after the string. To suppress it, use the NOCR 
keyword. For example: 

_var = "example" 
_item = "ECHO statement." 
ECHO "This is an _var of the " NOCR 
ECHO _item 
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displays  

This is an example of the ECHO statement. 

on your screen. 

The ECHO statement is not used to send commands to an online host 
(use the SEND statement). The results of ECHO statements and host 
commands are mixed in the session window and transcript. As a result, it 
can appear that commands are being sent to the host when they are not. 
 For example, 

ECHO "Enter your search term:" 

appears as 

=> Enter your search term: 

on STN. You may wish to use an extra ECHO to avoid this.  For example, 

ECHO ""     \* outputs a blank line to the screen 
ECHO "Enter your search term:" 

appears as 
=> 
Enter your search term: 
in the STN session and transcript. 

 

EDIT EDIT {ON | OFF} 

The EDIT statement is used to interact with the script processor by 
pausing the script before sending a command to the online host. An "Enter 
user data" box with the next command in it appears, allowing the 
command to be edited before it is sent. The changes made in the text 
editing box are not saved in the script file. The default is EDIT OFF. For 
example: 

=> FILE CAPLUS     \* This command is sent as-typed 
EDIT ON 
=> S ASPIRIN       \* This command can be modified  
                  \* before it is sent 
EDIT OFF 
=> D 1-3 ALL       \* This line is sent as-is 

You may use \! as a shortcut for the EDIT statement. Use \! on the => and 
: statement lines for STN scripts. The \! operator must occur at the end of 
the statement. 
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EXEC EXEC <file name> 

The EXEC statement is used to execute another script from within a script. 
The script file name is required. 

Scripts may be nested eight levels deep. Variables defined in the calling 
script are available in the called script. When the called script completes, 
processing continues on the line immediately after the EXEC statement in 
the calling script. For example: 

_filevar = <SECONDSCRIPT.sc> 
EXEC _filevar 
ECHO "_filevar has completed processing." 

executes the script SECONDSCRIPT.sc. Then it returns to the calling 
script and prints: 

SECONDSCRIPT.sc has completed processing. 

All scripts that are executed must reside in the User Scripts or Predefined 
Scripts folder as defined in General Preferences (located in the Setup 
menu on the Main Menu). The User Scripts folder is checked first for the 
script. If it is not found, the Predefined Scripts folder is checked. If the 
script is not found in either folder, an error message is displayed. 

If an error occurs, the _$filerror system variable is non-zero. 

 

EXIT EXIT  

The EXIT statement defines a point to leave the script. EXIT has no 
parameters. 

An exit is assumed after the last statement in a script. Thus, an EXIT 
statement is not required in any script. More than one EXIT statement may 
be used in a script. 

If an ONEXIT statement exists in a script, the ONEXIT block is executed 
before exiting. If the ONEXIT statement includes an EXIT statement, an 
exit occurs immediately when that EXIT is executed. 
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GET GET _varname [HIDDEN] [LABEL="string"] 

The GET statement is used to accept input from the keyboard. 

When a GET statement is reached in the script, text entry box is displayed 
in which the user may type. Typed characters, up to but not including the 
first carriage return, are placed in _varname. 

All typed input is scanned for a colon character (:). If found, GET returns 
only the characters that follow the colon. 

If the HIDDEN keyword is present, the typed characters are not displayed 
in the input box. 

If both the HIDDEN and LABEL keywords are present, HIDDEN must be 
first. 

For example, the statements 

ECHO "Please enter your password:" 
GET _passwd HIDDEN 

display 

Please enter your password: 

in the session window and prompts you for your password with an Enter 
User Data pop-up box: 

 

 

 

When your password is entered, it is stored in the _passwd variable but 
not displayed. 

Use the LABEL keyword to specify your own message in the pop-up box. 
For example: 

GET _passwd HIDDEN LABEL="Please type your password:" 
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causes the following dialog to be displayed: 

 

 

GOSUB GOSUB @label 

The GOSUB statement is used to branch to a different location (a 
subroutine) in the script with the option of returning to the statement that 
follows GOSUB. Subroutines are useful when an identical set of 
statements is executed from various points in the script. 

GOSUB has only one parameter, a label. When GOSUB is reached, script 
processing moves to the indicated label and continues processing until a 
RETURN statement is reached. The RETURN statement causes the script 
to continue with the statement following the GOSUB statement. 

GOSUBs may be nested up to eight levels. 

For example: 

ECHO "Right before the GOSUB." 
GOSUB @SUBROUTINE 
ECHO "Right after the GOSUB." 
EXIT 

@SUBROUTINE 
ECHO "Within the GOSUB." 
RETURN 

displays: 

Right before the GOSUB. 
Within the GOSUB. 
Right after the GOSUB. 
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GOTO GOTO @label 

The GOTO statement is used to direct script processing to a line that is not 
directly after the current line of a script. 

GOTO is similar to GOSUB except that there is no option to RETURN. 

For example: 

IF (_var1 = "FIRST") GOTO @LABEL1 
ECHO "Value of var1 is not FIRST." 
EXIT 

@LABEL1 
ECHO "Value of var1 is FIRST" 
EXIT 

outputs only one of the above ECHOed lines, depending on the value of 
_var1. 

 

IF IF (condition) block [ELSE block] 

The IF statement is used to execute one or more statements based on a 
condition or criteria. 

The IF/ELSE statement forms a construct that decides which statement to 
execute next. If the condition is true, the statement or block directly 
following the IF is executed. If the condition is false, the statement or block 
directly following the ELSE keyword is executed. If the condition is false 
and there is no ELSE keyword, the statement following the end of the IF 
block is executed. 

Use a BEGIN/END block when you want to execute more than one 
statement after IF or ELSE. 

For example: 

\* If no phone number was given, ask for it. Otherwise,
\* display the number. In either case, dial the number.
IF (_phoneno = "") BEGIN    \* multi-statement block  
  ECHO "Enter phone number:" 
  GET _phoneno 
  END 
ELSE 
  ECHO "Dialing _phoneno"   \* single-statement block 
SEND "ATDT _phoneno" 

Note that the SEND statement is outside the IF/ELSE construct. It is 
executed regardless of the condition. 
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ONEXIT ONEXIT block 

ONEXIT is used to specify a set of statements to always execute before 
leaving a script. 

The ONEXIT statement may be placed anywhere within a script. An 
ONEXIT block cannot contain a GOTO or RETURN statement. 

When the script processor reaches an EXIT statement and an ONEXIT 
block has been defined, processing jumps to the ONEXIT block. After the 
ONEXIT block has been completed, the script ends. An EXIT statement 
within an ONEXIT block causes an immediate exit (the ONEXIT block is 
not executed again). 

The block portion of the statement may be entered as one line, or as a set 
of statements between BEGIN and END. 

For example, the statements: 

ONEXIT BEGIN 
  ECHO "These two lines will always be" 
  ECHO "executed upon exiting the script." 
END 

cause the two lines to be displayed to the screen when you leave the 
script. 

 

OPEN OPEN [<file name>] [ {/R | /W} ] 

The OPEN statement is used to open a new or existing file from within a 
script. 

The file name is optional. If no file name is supplied, you are prompted to 
enter one. 

The file name can be a full path, such as C:\Docs\Project2\data.txt, or a 
simple name, such as data.txt. If it is a simple file name, the file is opened 
in the Uscripts folder. 

The /R option opens the file to read only. The /W option allows both 
reading and writing in the file. The default option is /W. 

All data written to the file is appended to the end of the file. To rewrite a file 
completely, delete it before opening it. 

For example: 

_error = "Command timed out. Error ##36." 
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DELETE <errors.txt>   \* Delete errors.txt from 
Uscripts 
OPEN <errors.txt>     \* Open (and create) file in 
Uscripts 
WRITE _error 
CLOSE 

places the following message in a file named errors.txt: 

Command timed out. Error #36. 

If an error occurs, the _$filerror system variable is non-zero. 

 

PAGE PAGE 

The PAGE statement forces the captured transcript to begin a new page. 

Page breaks appear when Browsing a standard transcript as 

<------Page Break------> 

and are preserved when saved as RTF. 

 

PAUSE PAUSE {n [SECOND[S]] | [UNTIL time]} 

Use the PAUSE statement to halt script processing for a period of time or 
until a specific time of day. 

Enter the number of seconds, n, as an integer or a variable. If n equals 
zero, the pause is forever. 

The UNTIL time option allows you to specify a certain time of the day, 
using a 24-hour clock. 

For example: 

PAUSE 1 SECOND             \* pause for 1 second 
PAUSE UNTIL 14:45          \* pause until 2:45 pm 

 

PRINT PRINT {ON | OFF} 

Use the PRINT statement to turn "slave" printing on or off. Slave printing 
causes the transcript to be printed as the online session progresses. Slave 
printing is not recommended. 
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RAISE 
DTR 

RAISE DTR 

Use the RAISE DTR statement to set the modem's DTR (Data Terminal 
Ready) circuit to an "on" state. See also DROP DTR. 

 

READ READ _varname 

The READ statement reads a single line from the OPEN file and stores the 
value, without a carriage return character, in _varname. For example 

: 

ECHO "reading first line of INPUT FILE" 
OPEN <input.txt> 
READ _line 
CLOSE 

The file input.txt is opened and the first line is read into the variable _line. 

If an end-of-file condition is reached or an error occurs, the _$filerror 
system variable will be non-zero. 

 

RETURN RETURN 

The RETURN statement is used to return to the point from which a 
subroutine was invoked by a GOSUB statement. For example: 

GOSUB @SUBROUTINE 
ECHO "processing will return to this point." 
EXIT 

@SUBROUTINE 
ECHO "After printing this line..." 
RETURN 

displays the following: 

After printing this line... 
processing will return to this point. 
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SEND SEND "string" [EDIT] [HIDDEN] [NOCR] 

The SEND statement is used to send a character string to the online host. 
(Technically, the string is sent to the communication port specified in the 
logon setup. Therefore, for example, a string can be sent to a modem 
before STN Express is connected to the host.) 

The string and other parameters may occur in any order after the SEND 
statement. The "=>" and ":" statements are specific forms of SEND. 

EDIT is an option that allows the string to be edited before it is sent. EDIT 
works as \! does in the => and : statements. 

HIDDEN does not display the string as it is sent. This is useful when 
sending passwords. 

A carriage return is automatically included after the string. To suppress it, 
use the NOCR keyword. 

For example: 

SEND "+++" NOCR 
SEND "ATDT 555-1212" 

sends: 

+++ATDT 555-1212 

to the modem. 

 

STNLOGON STNLOGON 

The STNLOGON statement is used to execute the STNLOGON script 
that logs you on to STN International. STNLOGON assumes that there is 
already a connection to STN. Specifically, STNLOGON sends a carriage 
return and expects the reply to be "Welcome to STN International! Enter 
x:". 

 

SUBSTR SUBSTR (_var, begin, length) 

SUBSTR is a function that takes a string of characters in a variable and 
returns a "substring" or portion of the string. The returned  substring begins 
with character number begin and continues for length characters. Begin 
and length may be literal numbers or variables. For example, the 
statements: 

_var1 = "xxx remove this portion xxx" 
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_var2 = SUBSTR(_var1, 5, 19) 
ECHO _var2 

display the following contents of _var2: 

remove this portion 

SUBSTR may be used in conditions. For example: 

_len = 3 
IF (SUBSTR(_var1,1,_len) = "xxx") GOTO @label 

When the script runs, if begin is beyond the end of the string, a variable 
substitution error is given. 

 

TRYAGAIN TRYAGAIN n [TIMES] [ [THEN] block] 

The TRYAGAIN statement is part of a WAIT block and is used to repeat 
the previous SEND statement a specified number of times. 

This statement works only in the context of the SEND-WAIT statement 
pair. It repeats the previous SEND up to n times. After the nth attempt, 
processing either performs the THEN block or EXITs. 

For example: 

SEND "ATDT 555-1212" 
WAIT 
  FOR "CONNECT" CONTINUE 
  FOR "NO CARRIER" EXIT 
  FOR 5 SECONDS 
  TRYAGAIN 5 TIMES THEN GOTO @failed 

This script sends the phone number and waits 5 seconds for either 
CONNECT or NO CARRIER. If the response is not received, the phone 
number is sent up to five more times. If the expected response is still not 
received, the process jumps to the @failed label. 

 

UPLOAD UPLOAD [LNUM _var1,_var2,_var3...] <file name> 

The UPLOAD statement is used to upload a structure query to STN. The 
result of the UPLOAD is one or more L-numbered queries. 

The LNUM keyword indicates the beginning of a list of variables. The 
variables are assigned the L-number or L-numbers of the uploaded 
structure. Usually, only one variable is needed. Multiple variables are 
needed when a reaction query with multiple participants is uploaded in an 
STN file that does not support reaction searching. In that situation, each of 
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the participants is uploaded into its own L-numbered query. Commas must 
separate variables in the list. 

<file name> is a full path to a .str query file created in Structure Drawing. 

For example: 

UPLOAD LNUM _line1 <C:\STNEXP\Queries\STR1.STR> 

This statement uploads the structure query file STR1.STR to STN and 
stores the resulting L-number value in the _line1 variable. 

If an error occurs, the _$filerror system variable is non-zero. 

 

USER USER 

The USER statement is used to temporarily halt script processing and give 
control of the online session to the user. Control is returned to the script 
when you press the END key. 

 

VT320 VT320 {ON | OFF} 

The VT320 statement is used to turn ON or OFF VT320 terminal emulation 
and is useful when you connect to STN via a VAX with a menu system and 
when you connect to an online host that offers a menu system. 

 

WAIT WAIT [ _var1] [LNUM _var2] for-list 

The WAIT statement is used to pause script processing until a specific 
response is received from the online host. This statement results in data 
being read from the incoming communication port one line at a time. A line 
includes everything up to a carriage return. 

After WAIT is executed, _var1 contains the last line received from the 
host. 

LNUM _var2 puts an L-number into the variable _var2. 

for-list is one or more: 

FOR for-condition [THEN] block 

This is defined as: "If for-condition is met, then execute these statements." 
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The block is optional, except for the last for-condition. Often the block 
contains a CONTINUE statement. 

For-condition is either: 

"string" (substring received from host) 

or: 

n [SECOND[S]] (passing of time, n, can be an integer or a variable) 

If n is zero, the WAIT is forever. 

See the example at the TRYAGAIN statement. 

 

WRITE WRITE "string" [NOCR] 

The WRITE statement writes a line of text into the currently-open file. 

WRITE places string in the open file, followed by a carriage return. If the 
NOCR keyword is present, the carriage return is suppressed. 

Lines are always appended to the end of the file. To erase the contents of 
the file before writing to it, use the DELETE statement. 

If an error occurs, the _$filerror system variable is non-zero. 

 

Script Tips • Scripts do not require a specific format or style as you type the 
statements, and more than one statement may appear on the same 
line. However, for ease of understanding the scripts you have written, 
use a style similar to what you see here. 

• To ensure that all STN Express features are available while you are 
online, use the STNLOGON script instead of writing your own 
commands to log on to STN. 

• Open a new script file by selecting New from the File menu within the 
STN Edit window. A new, Untitled window is displayed 

• Check Command File checks your script for some errors. Getting an 
error-free script from the command file checker does not guarantee 
that the script will do what it was intended to do. A clean bill of health 
from the command file checker also does not guarantee there are no 
errors in the script because some errors cannot be found until the 
script is run. 

• Add comments to a script by placing a \* anywhere on the line. To 
display a comment on the screen, use the ECHO statement. 

• Use comments to help you and others understandable your scripts. 
• Use blank lines to make your scripts more readable. 
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• Use a standard spacing and indentation scheme to make your scripts 
more readable. 

• When running a script, press the Escape or Clear key to stop the script. 
• All STN Express scripts must be in either the User Scripts folder or the 

Predefined Scripts folder. When looking for a script to execute, STN 
Express first checks the User Scripts folder, then the Predefined 
Scripts folder. 

• Enter only the unique portion of the prompt when using the WAIT FOR 
statement. 

• Use the SEND, WAIT FOR, and TRYAGAIN statements together 
because TRYAGAIN will resend the last item that was sent using a 
SEND statement. Many times, TRYAGAIN is an optional part of the 
statement trio because you would not want to resend some items, e.g., 
login ID or password. 

• You may use your own word processor to write a script as long as you 
save the file in a text-only format. 

 

Running a 
Script 

While you are logged on to STN, Select Run Command File from the 
Query menu. A Command File dialog is displayed. Select a script file to 
run and then click Open. The script runs until it finishes or until an error is 
found in the script. 

 

Script 
Examples 

Use this Help as your guide to writing STN Express scripts. The parts of 
the script language are described with important details. The descriptions 
of most statements include at least one example. Facts and tips are 
collected for your convenience.  

 Use the following scripts as models for scripts that meet your needs. Other 
scripts are available in the Scripts and PSSfiles folders in your STN 
Express installation. 

• Registry number search example script 
• Author search example script 
• Logon Scripts 

 

Registry 
Number 
Script 
Example 

Recall the script shown at the beginning of this section: 

\* Display CAS RNs in the Registry file on STN. 

=> FILE REGISTRY 

=> DIS 50-00-0 
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=> DIS 7777-77-7 

=> LOG Y 

It does its job but is not very flexible. For example, what if you have long 
list of CAS Registry Numbers instead of just a few? Use the OPEN, READ, 
IF, and CLOSE statements to process a file of Registry Numbers. 

\* STN Express script to read list of RNs from a file 

\* and display information for each Registry Number. 

\* Open the data file for reading. There is one RN on  

\* each line. 

OPEN <rnlist.txt>/R 

=> file registry 

\* Process all the RNs in the file 

@readloop 

  \* Read an RN from the data file. 

  READ _rn 

  \* If an RN was read, send a DISPLAY command to STN. 

  IF (_$filerror = 0) BEGIN 

    \* Display the requested substance  

    => dis _rn 

    GOTO @readloop 

  END 

\* Close the input file 

CLOSE 

=> 

EXIT 

 

140 



Using Scripts 

 

Author 
Search 
Script 
Example 

ECHO "" 

ECHO "This is a script for running author searches." 

ECHO "Press [Esc] at any time if you would like to\ 
stop." 

ECHO "" 

ECHO "In the pop-up box, enter the last or family\ name 
of the author:" 

GET _lastname LABEL="Last/family name:" 

ECHO "In the pop-up box, enter first or given name\ or 
initial:" 

GET _firstname LABEL="First/given name:" 

\* Use the STN expand command to provide choices of  

\* names. 

=> 

=> expand _lastname _firstname/au 

ECHO "Enter the e-numbers to search, e.g., e3-e5 or\ 
e3,e7) or end" 

GET _enums LABEL="Enter e-numbers:" 

IF (_enums = "end") BEGIN 

  ECHO "Ending author search at your request." 

  => 

  EXIT 

END 

=> 

=> search _enums \> _results 

\* If the search yielded zero answers, there is  
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\* nothing to display. Inform the user and exit. 

IF (#_results = 0) BEGIN 

  ECHO "There are no answers for your query." 

  => 

  EXIT 

END 

\* The search found hits, so ask how many should be  

\* displayed. 

ECHO "How many answers would you like to display? 
(e.g.,\ 

 #_results or 0):" 

GET _display 

IF (_display > 0) BEGIN 

  ECHO "Please provide a transcript name to use to\  

 save your answers." 

  CAPTURE ON <> 

  \* Don’t try to display more answers than are  

  \* available. 

  IF (_display > #_results) THEN _display = #_results 

  => 

  => dis 1-_display bib 

CAPTURE OFF <> 

END 

ECHO "Your author search is now complete." 

=> 

EXIT 
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Logon 
Scripts 

There are two separate steps to logging on to an online host: 

1.  Connecting to the host through a telecommunications network. 

2.  Logging on to the host. 

STN Express includes support for several telecommunications networks 
and online hosts. Before you take the time to write your own connection or 
logon script, find out whether STN Express already provides the scripts 
you need. Also, you may find it easier to use the Watch Me feature than to 
write your own logon script. 

 

 

Predefined 
Logon 
Setup 
Variables 

If you intend to write your own scripts that connect through a network or 
log on to an online host, be sure you understand the details of a logon 
setup. Many of the values defined in a logon setup are available to STN 
Express scripts as variables. Below is a list of these variables and the 
fields in the setup dialogs to which they correspond. 

Setup 
Definition 
Dialog 

Host Information 

_$LOGID Login ID 
_$PASSWORD Password 
_$SERVICE Host Name; set to "STN" for all STN 

hosts 
_$STNCENTER name of STN Node (Columbus, 

Karlsruhe, or Tokyo) 

 

Path 

_$CONNVIA Connect via 
_$NETWORK Value selected from network list when 

the Logon Method is Standard 
_$NUA NUA (Network User Address) 
_$NUI NUA (Network User Address) 
_$NUP NUP (Network User Password) 
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Communication Settings 

_$BAUD Speed 
_$DIALTYPE Dial 
_$PHONENO Primary Phone # 
_$PHONENO2 Secondary Phone # 

   

Host Settings 

_$QSERVNAME Choice of Service (Questel only ) 
_$GRAPHICS Graphics (STN only) 
_$STNPORT STN Port (STN only) 

 
 

Advanced 
Dialog 

Prompt Character strings 

 

Optional 

_$GWID Gateway Login ID 
_$GWPW Gateway Password 

 

Execute at command prompt 

_$GWCOMM1 Value of first (top) "Execute" box 
...  
_$GWCOMM5 Value of fifth (bottom) "Execute" box 

 

Modem Configuration 

_$MODINIT Initialization String  
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Predefined 
STN 
Variables 

In addition to predefined logon setup variables, other variables related to 
your STN session are available to you. 

 _$CENV the current STN file environment (a list 
of STN files in capital letters) 

_$ENUM the current E-number 
_$LANS number of answers in the most recent 

L-number 
_$LNUM the most recent L-number 
_$LENV the STN file environment on entry to the 

script  
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